
Chapter 2

Working with Basic 
Tools 

Learning Objectives
After completing this chapter, you will be able to:
• Invoke tools
• Create keypoint curves
• Create text
• Understand the features of curves
• Create basic curves
• Create primitives
• Use different pick tools
• Use transform tools
• Shade objects



2-2						            Learning Autodesk Alias Design
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

INTRODUCTION TO BASIC TOOLS
In the previous chapter, you have learned about the Alias interface and the location of various 
tools. In this chapter, you will learn about the basic tools that are used to create the entities 
like curves, lines, arcs, primitives, and so on. You will also learn about the tools that are used 
to transform and pick the entities created. The transform tools are used to move, rotate, and 
scale objects. 

INVOKING TOOLS
The tools for creating sketched entities and surfaces, transforming surfaces, and editing the 
entities are available in the Palette, Shelves window, and Control Panel. The tools in the Palette 
are placed under different tabs. Choose a tab; the respective tools will be displayed. Then, 
left-click on the required tool; the tool will be invoked and enclosed in a red box in the Palette. 
Figure 2-1 shows the Move tool being invoked after expanding the Transform tab in the Palette. 
You can also invoke a tool without expanding the tab. To do so, right-click on the tab; a shortcut 
menu with all tools associated with the tab will be displayed, as shown in Figure 2-2. Left-click 
on the required tool to invoke it.

Figure 2-2  Shortcut menu  displayed on 
right-clicking on the Transform tab

Figure 2-1  Invoking the Move tool after 
expanding the Transform tab 

METHODS OF CREATING OBJECTS
In Alias, there are two methods to create an object. The first method is to create an object (curves, 
surfaces, and so on) with default parameters or settings. The second method is to first set the 
parameters of an object and then create it. In this chapter, the first method is discussed for 
creating these objects. The effect of changing the parameters of these objects is also discussed 
in this textbook.
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CREATING KEYPOINT CURVES
The curves that retain attribute information such as

Figure 2-3  The Keypoint Curve Toolbox

 
radius, sweep angle, and center point are known as 
keypoint curves. These curves retain constraints and 
relationships that can be used to edit them. To invoke 
any keypoint curve tool, choose the Keypoint Curve 
Toolbox tool from the Curves tab in the Palette; the 
Keypoint Curve Toolbox will be displayed, as shown 
in Figure 2-3. Next, invoke a tool from this window 
to create the corresponding keypoint curve. By 
default, guidelines are displayed when you create any 
keypoint curve. These guidelines help you align the 
curves with each other. You can turn off the display 
of these guidelines by choosing WindowDisplay > Toggles > Guidelines from the menu bar. 
Information retained by the keypoint curves can be viewed in the Information Window. You can 
modify the keypoint attributes by changing their values in this window. The different keypoint 
curves that can be created in Alias are discussed in the next section.

Tip: You can get the information such as attributes, transformation, pivot, bounding box, and 
curve geometry about any curve, whether a line or an arc, from the Information Window 
dialog box. To invoke this dialog box, first select the curve from the active window and then 
choose Windows > Information > Information Window from the menu bar. Alternatively, 
you can press CTRL+5 keys to display the Information Window dialog box.

Creating a Line
  Palette:	 Curves > Keypoint Curve Toolbox > Lines > Line  

To draw a line, choose the Line tool from

Figure 2-4  Line drawn in the active window

 
the Keypoint Curve Toolbox; you will 
be prompted to specify the start point of 

the line. Specify the position by entering 
coordinates in the promptline. You can also 
specify the start point of the line by clicking in 
the active window. After specifying the start 
point, you will be prompted to specify the 
endpoint of the line. Specify the endpoint of 
the line; the line will be created in the active 
window with the start point, midpoint, endpoint, 
and the guidelines displayed on it, as shown in 
Figure 2-4. Note that the moment you click to 
specify the endpoint of the line and keep the left mouse button pressed, its linear dimension 
will be displayed, as shown in Figure 2-5. But, after specifying the endpoint, the dimension will 
disappear. You can draw horizontal or vertical line using the steps given next.

1.	 If you specify the endpoint of the line by using the middle mouse button a horizontal 
keypoint line will be created, as shown in Figure 2-6.

2.	 If you specify the endpoint of the line by using the right mouse button a vertical keypoint 
line will be created, refer to Figure 2-6.
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Figure 2-6  Vertical and horizontal keypoint lines 
created

Figure 2-5  Linear dimension displayed on the 
line  

To set the parameters of the Line tool, double-click on

Figure 2-7  The Line (2 Point) Options 
dialog box

 
the Line tool; the Line (2 Point) Options dialog box will 
be displayed, as shown in Figure 2-7. The options in this 
dialog box are discussed next.

Degree
This edit box is used to specify the degree of the line. The 
range of the degree is 1 to 7. By default, 1 is displayed in 
this edit box. You can also change the degree of the line 
by using the slider bar given on the right of this edit box.

Reset
This button is used to revert to the default settings or parameters of the Line tool. 

Apply
This button is used to save the current parameter values in the Line (2 Point) Options dialog box. 
The next time when you invoke this dialog box for creating another line, the saved parameter 
values will be displayed in the dialog box again. 

Exit
This button is used to exit the Line (2 Point) Options dialog box. 

Go
Choose this button to draw the line with the modified parameter values. In this case, the values 
set will not be saved for the next line to be drawn.

After specifying all parameters of the line, choose the Go button to draw the line. Specify the 
start and the endpoint; the line with the specified settings will be created in the window.

To exit the Line tool, choose the Pick Object tool from the Pick tab in the Palette. The tools in 
the Pick tab of the Palette will be discussed in detail later in this chapter.
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Creating Polylines
 Palette:	 Curves > Keypoint Curve Toolbox > Lines > Polyline  

You can draw continuous lines by using the Polyline tool. While creating a polyline,  the 
endpoint of the previous line becomes the start point of the next line and you need to 
specify only the endpoints of the successive lines. To create a polyline, press and hold 

the left mouse button on the Lines flyout from the Keypoint Curve Toolbox; a flyout will be 
displayed. Choose the Polyline tool from this flyout; the button will get enclosed within a red 
box, indicating that the tool is active. Also, you will be prompted to specify the start point of the 
polyline. Click in the active window or enter the coordinates in the promptline to specify the 
start point of the line and press ENTER; you will be prompted to specify the endpoint of the 
line. Specify the endpoint of the first line segment of the polyline and continue specifying the 
endpoints of the successive line segments until you have created the polyline of required segments. 
Next, choose the Pick Object tool from the Pick tab in the Palette to exit the Polyline 
tool. Figure 2-8 shows a three-segment polyline created by using the Polyline tool.

To set the parameters of the Polyline tool, double-click on it; the Line Poly Options dialog box 
will be displayed, as shown in Figure 2-9. The options in this dialog box are the same as those 
discussed in the Line tool.

Figure 2-8  A three-segment polyline Figure 2-9  The Line Poly Options dialog box

 

Creating a Parallel Line
  Palette:	 Curves > Keypoint Curve Toolbox > Lines > Parallel Line 

You can create a line parallel to an existing line or curve by using the Parallel Line tool. 
Invoke the Parallel Line tool from the Lines flyout in a way similar to the Polyline tool. 
On doing so, you will be prompted to select a curve to which you need to draw the parallel 

line. Select the curve or the line from the active window; you will be prompted to specify the 
start point of the line. Click in the active window or enter the coordinates in the promptline to 
specify the start point of the line; you will be prompted to specify the endpoint of the line. 
Specify the endpoint; a line parallel to an existing line will be created, as shown in Figure 2-10. 
If you select a circle or an arc, a tangent guideline will be displayed and the line drawn will be 
parallel to this tangent guideline, as shown in Figure 2-11.

To set the parameters of the Parallel Line tool, double-click on it; the Line Parallel Options 
dialog box will be displayed. The options in this dialog box are the same as those discussed in 
the Line tool.
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Figure 2-11  Line parallel to the tangent line of 
the three point arc

Figure 2-10  Line parallel to the existing line

Note
When you click to specify the first point of the parallel line, the linear distance between the two lines 
is displayed momentarily between the two lines. Similarly, when you click to specify the endpoint of 
the parallel line, the linear dimension of the line is displayed momentarily on the line.

Creating a Line at Angle
  Palette:	 Curves > Keypoint Curve Toolbox > Lines > Line at Angle 

You can create a line at an angle to an existing line or a curve by using the Line at Angle 
tool. Invoke the Line at Angle tool from the Lines flyout in a way similar to the Polyline 
tool; you will be prompted to select a curve to make the line inclined to. Select a curve 

or a line from the active window; you will be prompted to specify the endpoint of the line or the 
relative angle. Click in the active window or enter the angle in the promptline. If you click in 
the active window, a new line at an arbitrary angle value to the existing curve or line will be 
created, as shown in Figure 2-12. If you enter an angle in the promptline and then click in the 
active window to specify the endpoint, a new line at the specified angle in the clockwise direction 
to the existing curve will be created. In case of a curve, the new line will be created at an angle 
to the line that passes through the start point of the line and the endpoint of the curve, as shown 
in Figure 2-13. While specifying the endpoint of the line, drag the endpoint to display the 
angular dimension of the line. Note that this angular dimension will disappear after you specify 
the endpoint of the line. 

To set the parameters of the Line at Angle tool, double-click on it; the Line Angle Options 
dialog box will be displayed. The options in this dialog box are the same as those discussed in 
the Line tool.

Tip: You can use the Snap to CV/Edit Point and Snap to Curve buttons on the right 
of the promptline to draw the lines (parallel, perpendicular, tangent, and so on) from/at a 
specific curve or a CV/edit point. 
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Figure 2-13  A line created at an arbitrary 
angle to the existing curve 

Figure 2-12  A new line created at an arbitrary 
angle to the existing line 

Creating a Circular Arc
  Palette:	 Curves > Keypoint Curve Toolbox > Circular Arc 

You can create a circular arc or circle by specifying its center point and a point on its 
circumference. You can do so by using the Circular Arc tool. To draw a circular arc using 
this tool, choose the Circular Arc tool from the Keypoint Curve Toolbox; you will be 

prompted to specify the center point of the circle. Click in the active window to specify the center 
point of the circle; you will be prompted to specify a point on the radius of the circle. Click in 
the active window at the required distance from the center point; a circle will be created, as 
shown in Figure 2-14. While specifying the location on the radius of the circle, the dimension 
is displayed momentarily in green on the screen. Note that the dimension varies as you drag 
the mouse and disappears after you specify the endpoint of the circle.

To set the parameters of the Circular Arc tool, double-click on the Circular Arc tool; the Circle 
Options dialog box will be displayed, as shown in Figure 2-15.

Figure 2-14  Circle created using the Circular 
Arc tool

Figure 2-15  The Circle Options dialog box

The options in this dialog box are discussed next.
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Degree
This edit box is used to specify the degree of the circular arc. The range of the degree is 2 to 
7. By default, 6 is displayed in this edit box. You can also change the degree of the arc by using 
the slider bar given on the right of this edit box.

Spans
This edit box is used to specify the number of spans of the circular arc. The range of spans is 
1 to 14. By default, 1 is displayed in this edit box. You can also change the spans of the arc by 
using the slider bar given on the right of this edit box.

Creating an Ellipse
  Palette:	 Curves > Keypoint Curve Toolbox > Ellipse  

To create an ellipse, choose the Ellipse tool

Figure 2-16  The New Ellipse Options 
dialog box

 
from the Keypoint Curve Toolbox; you will 
be prompted to specify the center of the 

ellipse. Click in the active window; you will be 
prompted to specify the endpoint for the ellipse 
major axis. Click in the active window; the ellipse 
will be created. Note that the major and minor radii 
of the ellipse will be displayed when you specify the 
endpoint for the ellipse. Also, the dimensions of both 
the axes keep changing as you drag the mouse.

To set the parameters of the Ellipse tool, double-click 
on the Ellipse tool; the New Ellipse Options dialog 
box will be displayed, as shown in Figure 2-16.

The options in the New Ellipse Options dialog box are discussed next.

Ellipse definition 
The Ellipse definition area is used to specify the option for creating an ellipse. The two 
radio buttons in this area are discussed next.

Axis Endpoints
You can select this radio button to create an ellipse by specifying the endpoints of the major 
axis. On selecting this radio button, you will be prompted to specify the start point of the 
major axis. You can specify the start point by entering the coordinates in the promptline 
or by clicking at the required location in the active window. After specifying the start point, 
you will be prompted to specify the endpoint of the major axis. The ellipse created using 
the Axis Endpoints radio button is shown in Figure 2-17. To specify the endpoint, click on 
the screen; the dimensions will be displayed momentarily in green color. These dimensions 
will disappear after you specify the endpoint.

Centre And End Point
The Centre And End Point radio button is selected by default and is used to create an ellipse 
by specifying the center and the endpoint of the major axis. With this radio button selected, 
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you need to specify the center point of the ellipse. Specify the center by entering the 
coordinates in the promptline or click at the required location in the active window; you will 
be prompted to specify the endpoint of the major axis of the ellipse. The ellipse created by 
selecting the Centre And End Point radio button is shown in Figure 2-18.

Figure 2-18  Ellipse created on selecting the 
Centre And End Point radio button

Figure 2-17  Ellipse created on selecting the 
Axis Endpoints radio button

 

Axis length ratio
Axis length ratio is the ratio of the length of the minor axis to that of the major axis. You can 
specify this ratio by entering a value in the Axis length ratio edit box. You can also specify the 
value using the slider bar given on the right of this edit box. Figure 2-19 shows ellipses created 
with axis length ratios of 0.3 and 0.8.

Sweep
You can enter the value of the sweep angle of the ellipse in the Sweep edit box. By default, its 
value is 360 degrees. If you need to create an open ellipse, enter a value between 0 degree to 
360 degrees. Figure 2-20 shows ellipses created with sweep angles 180 and 270 degrees.

Figure 2-20  Ellipses created with different 
sweep angles

Figure 2-19  Ellipses created with different 
axis length ratios

Creating a Rectangle
  Palette:	 Curves > Keypoint Curve Toolbox > Rectangle  

In Alias, you can create a rectangle by  specifying the starting and ending positions of 
the rectangle. To do so, you can use the Rectangle tool. The starting and ending positions 
of the rectangle are its two diagonally opposite corners. To create a rectangle, choose the 

Rectangle tool from the Keypoint Curve Toolbox; you will be prompted to specify the starting 
position of the rectangle. You can specify the starting position by entering the coordinates in 
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the promptline or by clicking at the required location in the active window. On specifying the 
starting position, you will be prompted to specify the ending position of the rectangle. Specify 
the ending position; the rectangle will be created, as shown in Figure 2-21.

Figure 2-21  Rectangle created in the 
orthographic window

Creating a Three Point Arc
  Palette:	 Curves > Keypoint Curve Toolbox > Arcs > Arc (Three Point)  

You can create an arc by specifying three points. You can do so by using the Arc (Three 
Point) tool. To create a three point arc, choose the Arc (Three Point) tool from the Arcs 
flyout of the Keypoint Curve Toolbox; you will be prompted to specify the first point. 

Click in the active window or enter the coordinates in the promptline to specify the first point. 
Next, specify the second and third points of the arc; the three point arc will be created, as shown 
in Figure 2-22. You can specify the second and third point of the arc in three different ways by 
using the three mouse buttons. Click in the active window with the middle mouse button; the 
point will be placed horizontally with respect to the previous point. If you specify the point with 
the right mouse button, the point will be placed vertically with respect to the previous point. If 
you specify the point with the left mouse button, the point will be placed freely. If you drag the 
mouse to specify the third point of the arc, the center point of the arc as well as its radius will 
change dynamically, as shown in Figure 2-23.

Figure 2-23  Radius displayed on the arc while 
dragging the endpoint

Figure 2-22  A three point arc
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To set the parameters of the Arc (Three Point) tool,

Figure 2-24  The Arc (3 Point) Options 
dialog box

 
double-click on the Arc (Three Point) tool; the Arc 
(3 Point) Options dialog box will be displayed, as 
shown in Figure 2-24. 

The options in this dialog box are discussed next.

Degree
This edit box is used to specify the degree of the three 
point arc. The range of the degree is from 2 to 7. You 
can also change the degree of the arc by using the 
slider bar given on the right of this edit box.

Spans
This edit box is used to specify the spans of the three point arc. The range of the spans is from 
1 to 14. By default, 1 is displayed in this edit box. You can also change the spans of the arc by 
using the slider bar given on the right of this edit box.

Creating a Two Point Arc
  Palette:	 Curves > Keypoint Curve Toolbox > Arcs > Arc (Two Point)  

You can create an arc by specifying the two endpoints and the center point in succession. 
You can do so by using the Arc (Two Point) tool. To create a two point arc, press and hold 
the left mouse button on the Arcs flyout in the Keypoint Curve Toolbox; a flyout will be 

displayed. Choose the Arc (Two Point) tool from this flyout; you will be prompted to specify the 
start point of the arc. Click in the active window or enter the coordinates in the promptline to 
specify the start point; you will be prompted to specify the endpoint of the arc. Specify the 
endpoint; you will be prompted to specify the center

Figure 2-25  Two point arc displaying the 
radius of the curve

 
or the radius of the arc. Click in the active window to 
specify the center/radius of the arc; the two point arc 
will be created. When you click to specify the 
center/radius of the arc, the radius of the arc will be 
displayed momentarily in the active window, as shown 
in Figure 2-25. You can also enter radius of the arc in 
the promptline. On specifying the center/radius, you 
will notice that two possible curves that can be created 
are displayed. Click on the side where you need the 
arc. While specifying the endpoint of the arc, the three 
mouse buttons function in a way similar to the Arc 
(Three Point) tool.                                                                               

To set the parameters of the Arc (Two Point) tool, double-click on the Arc (Two Point) tool; the 
Arc (2 Point) Options dialog box will be displayed. The options in this dialog box are the same 
as those discussed in the Arc (Three Point) tool.
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Creating an Arc Tangent to a Curve
  Palette:	 Curves > Keypoint Curve Toolbox > Arcs > Arc Tangent to Curve 

The Arc Tangent to Curve tool is used to create an arc that is tangent to an existing 
curve or a line. To create an arc tangent to a curve, choose the Arc Tangent to Curve tool 
from the Keypoint Curve Toolbox; you will be prompted to select the location on the 

curve from which the arc tangent to the curve will start. Select the existing curve or line at any 
point to start the tangent arc, you will be prompted to specify the endpoint of the tangent arc. 
Click in the active window or enter coordinates in the promptline to specify the endpoint; the 
arc tangent to the line will be created, as shown in Figure 2-26. 

To set the parameters of the Arc Tangent to Curve tool, double-click on it; the Arc Tangent 
To Curve Options dialog box will be displayed. The options in this dialog box are the same as 
those discussed in the Arc (Three Point) tool.

Creating a Concentric Arc
  Palette:	 Curves > Keypoint Curve Toolbox > Arcs > Concentric Arc  

You can create an arc that is concentric to an existing arc by using the Concentric Arc 
tool. To create such an arc, choose the Concentric Arc tool from the Arcs flyout in the 
Keypoint Curve Toolbox; you will be prompted to select the arc to which the arc will be 

concentric. Select an existing arc; you will be prompted to specify the start point of the arc. Click 
in the active window or enter coordinates in the promptline to specify the start point. Next, you 
will be prompted to specify the endpoint of the arc. Specify the endpoint of the arc; the concentric 
arc will be created, as shown in Figure 2-27.

Figure 2-27  Concentric arcsFigure 2-26  Arc tangent to the line

To set the parameters of the Concentric Arc tool, double-click on it; the Concentric Arc Options 
dialog box will be displayed. The options in this dialog box are the same as those discussed in 
the Arc (Three Point) tool.

Creating a Line Tangent to a Curve
  Palette:     Curves > Keypoint Curve Toolbox > Line Tangent & Perp > Line Tangent to Curve  

You can create a line tangent to an existing curve by using the Line Tangent to Curve 
tool. To draw a line tangent to a curve using this tool, choose the Line Tangent to Curve 
tool from the Keypoint Curve Toolbox; you will be prompted to specify the start point 
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of the line. Click in the active window or enter the coordinates in the promptline to specify the 
start point of the line; you will be prompted to select the curve to which the line will be tangent. 
Select the existing curve from the active window; the line tangent to a curve will be created, as 
shown in Figure 2-28. If this line does not find any tangent, a prompt will be displayed showing 
the error message as well as the instruction to select the curve to which the line will be tangent. 
If there are more than one tangent, the line will be created to the nearest tangent.

Creating a Line Tangent from/to Curves
  Palette:	 Curves > Keypoint Curve Toolbox > Line Tangent & Perp  				  
		  > Line Tangent from/to Curve	   					           

You can create a line that is tangent to the two existing curves by using the Line Tangent 
from/to Curve tool. To invoke the Line Tangent from/to Curve tool, press and hold the 
left mouse button on the Line Tangent & Perp flyout available in the Keypoint Curve 

Toolbox; a flyout will be displayed. Choose the Line Tangent from/to Curve tool from this 
flyout; you will be prompted to select the curve from which the tangent line should start. Select 
one of the existing curves in the active window; you will be prompted to select the curve at which 
the tangent line should end. Select the second existing curve from the active window; a line 
tangent to the two selected curves will be created, as shown in Figure 2-29. If this line does not 
find any tangent, a prompt will be displayed showing the error message as well as the instruction 
to select the curve to which the line will be tangent. If there are more than one tangents, the 
line will be created at the nearest tangent.

Figure 2-29  Line tangent to two curvesFigure 2-28  Line tangent to curve

Tip: If there are two circles or circular arcs, then two possible tangent lines can be created. 
In such a case, you can click at the quadrant where you need to create a tangent line.

Creating a Line Perpendicular to a Curve
  Palette:	 Curves > Keypoint Curve Toolbox > Line Tangent & Perp > Line Perpendicular 

You can create a line perpendicular to an existing curve by using the Line Perpendicular 
tool. The line is drawn perpendicular in such a way that it is normal to the apparent 
tangent of the curve. Choose the Line Perpendicular tool from the Line Tangent & Perp 

flyout of Keypoint Curve Toolbox; you will be prompted to select the curve or the surface to 
which the line will be perpendicular. Also, six buttons namely, True, Projected, From Curve, 
To Curve, Next, and Change Settings will be displayed at the bottom of the active window. 
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Select the curve or the surface; you will be prompted to define the endpoint of the perpendicular 
line. Click at the required position on the active window; a line perpendicular to the curve will 
be created, as shown in Figure 2-30. Also, you will be prompted to change the length of the 
perpendicular line either by modifying the position of the points or by entering the length in 
the promptline. Modify the length by dragging the line or entering the value at the promptline. 
To create a new perpendicular line, choose the Next button from the bottom of the active window. 

You can create a line perpendicular to or from a curve with true or projected length. By default, 
the line created will be perpendicular to the curve in 3D space (as viewed from Perspective 
window). To change the default settings, choose the Change Settings button; all buttons will get 
activated and you can specify the new settings by choosing the required buttons. If you choose the 
Projected button from the active window, the line created will be perpendicular to the selected 
curve in the active orthographic window. With the From Curve button chosen, the start point 
of the perpendicular line will lie on the curve. If you choose the To Curve button, the endpoint 
of the perpendicular line will lie on the curve. 

To set the parameters of the Line Perpendicular tool, double-click on it; the Line Perpendicular 
Options dialog box will be displayed, as shown in Figure 2-31. 

Figure 2-30  Line perpendicular to a curve Figure 2-31  The Line Perpendicular 
Options dialog box

The options in this dialog box are discussed next. 

Degree
This edit box is used to specify the degree of the perpendicular line. The range of the degree 
is from 1 to 7. You can also change the degree of the arc by using the slider bar given on the 
right of this edit box.

Type
This area can be used to specify the type of perpendicular line that will be created. The radio 
buttons in this area are discussed next.

True
This radio button is selected by default and creates a line perpendicular to the selected 
curve in 3D space(as viewed from Perspective window).
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Projected
Select this radio button to create a line perpendicular to the selected curve in the active 
orthographic window.

Select
This area can be used to specify whether the line will start from the curve or end at the curve. 
The radio buttons in this area are discussed next.

From Curve
This radio button is selected by default and creates the line perpendicular to the curve such 
that its start point lies on the curve. In this case, you need to specify the endpoint at any 
location in the active window.

To Curve
Select this radio button to create the perpendicular line such that the endpoint of the 
perpendicular line will lie on the curve. In this case, you need to specify the start point at 
any location in the active window.
 

Creating Linearcs
 Palette:	 Curves > Keypoint Curve Toolbox > Line-arc 

In Alias, you can create a set of alternate lines and

Figure 2-32  The linearc

 
arcs tangent to it. To create a set of alternate lines 
and tangent arcs, choose the Line-arc tool from the 

Keypoint Curve Toolbox; you will be prompted to specify 
the start point of the linearc. Click in the active window or 
enter the coordinates in the promptline; you will be 
prompted to specify the endpoint of the line. Specify the 
endpoint of the line; you will be prompted to specify the 
endpoint of the arc. Click in the active window or enter 
coordinates in the promptline. Repeat the process to create 
a line-arc, as shown in Figure 2-32. Note that the endpoint 
of the line becomes the start point of the arc. 

You can specify the endpoint of the linearc in three different 
ways by using the three mouse buttons. Click in the active 
window with the middle mouse button to specify the endpoint of the line; the endpoint will be 
placed horizontally with respect to the previous point. If you specify the endpoint with the right 
mouse button, the endpoint will be placed vertically with respect to the previous point. If you 
specify the endpoint with the left mouse button, the endpoint will be placed freely. Specify the 
endpoint of the arc in a way similar to the endpoint of the line. While specifying the endpoint of 
the line or the arc, drag the endpoint to display the dimension of the corresponding curve. Also, 
dragging the endpoint of the line or the arc changes the dimension of the corresponding curve.
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Note
The arc segment always projects forward from the previous line. This type of arc is known as the 
convex arc. The concave arc is an arc that projects backward. To create a concave arc, you need to 
edit the convex curve, about which you will learn in the later chapters. Also, if you want to create the 
same type of segment as the previous one, double-click while specifying the endpoint of the segment.

Creating Text
  Palette:	 Curves > Text 

You can create text in the active window by using the Text tool. To do so, choose the Text 
tool from the Curves tab in the Palette. Next, click in the active window to specify the 

start point of the text string; an arrowhead defining the start point will be displayed in the active 
window. Also, you will be prompted to enter the text string. Enter the text in the promptline; 
the text will be created. This text acts as a single object, but it consists of a string of characters. 
You can separate characters from the text string into individual objects by ungrouping the text. 
You can also create multiple strings of text in the active window. To exit the Text tool, choose 
the Pick Object tool from the Pick tab in the Palette. You can create surfaces from the text by 
using the Set Planar tool, which will be discussed in Chapter 3. Figure 2-33 shows the text 
created in the active window.

To set the parameters of the Text tool, double-click on it; the Text Options dialog box will be 
displayed, as shown in Figure 2-34.

Figure 2-34  The Text Options 
dialog box

Figure 2-33  Text created in the active 
window
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The options in the Text Options dialog box are discussed next.

Font
The Font area can be used to specify the font that is used to create text. By default, the Arial 
font is displayed in the Font Name display box. You can change font by choosing the required 
font from the font list given below the Font Name display box. Scroll down the font list to view 
all fonts. Note that the new settings will be applicable only to new entries.

Other Attributes                                         
This area is used to specify the attributes such as the style and size of the text. The options in 
this area are discussed next.

Style
Press and hold the left mouse button on the Regular button located on the right of the 
Style area to display a flyout with four styles: Bold, Bold Italic, Italic, and Regular. The 
font styles will change with respect to the font selected in the font list. 

Point Size
The Point Size edit box is used to specify the size of the text. By default, 24 is displayed in 
this edit box. You can change the text size by entering the new value in this edit box. You 
can also change the text size by using the slider bar given on the right of this edit box.  

Tip: To ungroup the characters of a string, select the string and then choose Edit > 
Ungroup from the menu bar; the characters of the string will behave as individual objects. 
An individual character may consist of more than one curve. You can ungroup the characters 
in a way similar to the text string.

FEATURES OF A CURVE
Alias Design provides you with various tools to create a curve. Before creating curves, you need 
to know about the features that are associated with the curves. The features of a curve play an 
important role in its editing, modification, transformation, inspection, and so on. The features 
of a curve are discussed next.

Control Vertices
Control vertices (CVs) are the points in 3D space

Figure 2-35  Curve with different CV symbols

 
that define and control the creation of curves. 
You can edit curves by changing the position of 
their control vertices (CVs). The CVs of a curve 
at different points are indicated by different 
symbols. The first CV is indicated by a ‘box’ 
symbol; the second CV by ‘u’ symbol; and the 
other CVs by ‘x’ symbol, as shown in Figure 2-35.

Edit Points
The edit points allow you to create and edit 
curves. These edit points also determine the 
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number of spans in a curve. The span is the length of the curve segment between two edit points. 
You can increase or decrease the number of edit points in a curve. Figure 2-36 shows the edit 
point of a curve.

Hulls
The lines joining the CVs of a curve are called hulls. The necessity of hulls arises when you 
increase the number of edit points and spans. Figure 2-37 shows the hull of a curve.

Figure 2-37  Hull of a curveFigure 2-36  Edit point of a curve

Note
1. You can change the symbol of the CVs and the edit points of a curve by choosing the box icon 
given on the right of the Draw Style option. The Draw Style option can be invoked by choosing 
ObjectDisplay > Draw Style from the menu bar.
 
2. While editing the curves with the edit points, the editing tool starts searching the new curve 
through which the edit points will pass. The calculations that are done to find the curve consume 
a lot of time. So, editing the curves with the edit points should be restricted to simple curves only. 

CREATING CURVES
In Alias Design, you can create different types of curves using the tools in the Curves tab of the 
Palette. The methods of creating the curves are discussed next. 

Creating a Circle
  Palette:        Curves > Circle  

To create a circle, choose the Circle tool from the Curves tab in the Palette; you will be 
prompted to specify the new circle position. Click in the active window; a circle will be 
created.

To set the parameters of the Circle tool, double-click on it; the Circle Options dialog box will 
be displayed, as shown in Figure 2-38. 

The options in the Circle Options dialog box are discussed next.
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Figure 2-38  The Circle Options dialog 
box

Periodic Circle
This check box is selected by default and is used to create a circle with closed curves. The closed 
curves are periodic or cyclic in nature. In other words, the first and the last CVs of the circle 
overlap. If you clear this check box, a circle with open curves will be created. In this case, the 
first and the last CVs of this circle will only touch each other. There will be no overlapping of 
the spans.

Degree
The Degree edit box is used to specify the degree of the NURBS circle. By default, 5 is displayed 
in the edit box.  

Sweep Angle
This edit box will be available only when you clear the Periodic Circle check box. The sweep 
angle defines the degree of rotation of the circle around its center. Enter the sweep angle of the 
circle in the Sweep Angle edit box.

Segments
This edit box will be available only when you clear the Periodic Circle check box. This edit box 
defines the number of segments of the curve. You can draw a circle with a segments that can be 
range from 1 to 16. Alternatively, you can change the segment value using slider bar available 
at the right side of the Segments edit box.

Spans
This edit box is used to specify the number of spans of the open curve circle. The range of arc 
span is from 1 to 20. You can also change the arc span by using the slider bar given on the right 
of the Spans edit box. Figure 2-39 shows a circle drawn with the values 4 and 7 entered in the 
Degree and Spans edit boxes, respectively. Figure 2-40 shows a circle drawn with the values of 
250, 5, and 7 entered in the Sweep Angle, Degree, and Spans edit boxes, respectively.
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Figure 2-40  Circle drawn with the values 250, 
5, and 7 entered in the Sweep Angle, Degree, 
and Spans edit boxes, respectively 

Figure 2-39  Circle drawn with the values 4 
and 7 entered in the Degree and Spans edit 
boxes, respectively   

Note
When you click in the active window to specify the position of the circle, a manipulator will be 
displayed at the center of the circle. The manipulator will be discussed in the later chapters. 

   

Creating a CV Curve
  Palette:	 Curves > New Curves > New CV Curve  

A curve created by defining specific points

Figure 2-41  Curve created using the New 
CV Curve tool

  
that do not lie on the curve is known as CV 
curve. The specific points on a CV curve act 

as control vertices for the curve. To create a CV curve, 
choose the New CV Curve tool from the New Curves 
flyout of the Curves tab in the Palette; you will be 
prompted to enter the new position of the CV. Click 
at the required location in the active window or enter 
the coordinates in the promptline to specify the 
position of the first CV; the CV will be placed in the 
active window. Next, you will be prompted again to 
specify the new position of the CV. Click in the active 
window or enter coordinates in the promptline to 
specify the new position. Similarly, specify other 
points to create the curve, as shown in Figure 2-41.

To set the parameters of the New CV Curve tool, double-click on it; the New CV Curve Options 
dialog box will be displayed, as shown in Figure 2-42.

The options in the New CV Curve Options dialog box are discussed next.

Knot Spacing
The Knot Spacing area is used to specify the parameters for the edit points. The two radio 
buttons in the Knot Spacing area are discussed next.
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Figure 2-42  The New CV Curve Options dialog box

Chord
Select this radio button to create the curve such that the edit points are parameterized by 
the chord length, that is, the cumulative distance between the two edit points. The starting 
point parameter value will be 0 and the endpoint parameter value of the curve will be equal 
to the chord length of the curve.

Uniform 
This radio button is selected by default. With this option, the edit points of the curve will 
have the parameter value in the integer system. The first edit point parameter value will 
be 0 and the next edit point parameter value will be equal to 1 and so on. 

Curve Degree
The Curve Degree area is used to specify the degree of the curve. The curve created will satisfy 
the linear, quadratic, cubic, and other equations depending on the radio button selected. There 
are five radio buttons in this area, 1, 2, 3, 5, and 7. The curve of 1, 2, or 3 degree will create 
linear, quadratic, or cubic curves, respectively. By default, the 3 radio button is selected.

Progressive Degree 
If the degree of a curve is ‘n’, you need to specify ‘n+1’ CVs to display the curve. If you select 
the Progressive Degree check box, the curve will be displayed after specifying the second CV 
irrespective of the degree of the curve. With this check box selected, you can view the degree 
and span changing in the Control Panel. However, the degree of the curve will increase up to 
the curve degree specified in the New CV Curve Options dialog box.
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Pivot Position
This area is used to specify the position of the pivot points (rotation and scaling pivots) on the 
drawn curve. The radio buttons in this area are discussed next.

Origin
This radio button is selected to position the pivot points at the origin (0,0,0).

Curve Center
This radio button is selected to position the pivot points at the center of the curve being drawn. 

First CV
This radio button is selected by default. As a result, the pivot points will be positioned at 
the first CV.

Bounding Box Center
This radio button is selected to position the pivot points at the center of the bounding box 
of the curve being drawn. 

Last CV
This radio button is selected to position the pivot points at the last CV of the curve being 
drawn. 	

Create Guidelines
This check box allows you to create two guidelines perpendicular to each other every time 
you place a CV. Make sure the display of guidelines is turned on. You can do so by choosing 
WindowDisplay > Toggles > Guidelines from the menu bar.

Show Pick Chooser
Select this check box to show the pick chooser while snapping the CVs to the coincident curves.

Note
You can change the number of guidelines displayed by using the General Preferences dialog box 
that has been discussed in Chapter 1.

Creating an Edit Point Curve
  Palette:	 Curves > New Curves > New Edit Point Curve  

A curve created by defining specific points, which lie on the curve, is known as an edit 
point curve. These specific points on an edit point curve are known as edit points. To 
create an edit point curve, hold the left mouse button on the New Curves flyout of the 

Curves tab in the Palette; a flyout will be displayed. Next, choose the New Edit Point Curve 
tool from the flyout; you will be prompted to enter the position of the edit point. Click anywhere 
in the active window or enter coordinates in the promptline to specify the position of the first 
edit point; the edit point will be placed in the active window. You will be prompted again to 
specify the new edit point position. Click in the active window or enter coordinates in the 
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promptline to specify the new edit point position.

Figure 2-43  Curve created using the New 
Edit Point curve tool 

 
When you create a curve using the New Edit Point 
Curve tool, you can define spans and view the curve 
after specifying the second point. The curve created 
using the New Edit Point Curve tool is shown in 
Figure 2-43.

To set the parameters of the New Edit Point Curve 
tool, double-click on it; the New Edit Point Curve 
Options dialog box will be displayed. The options 
in this dialog box are the same as explained earlier 
in the New CV Curve Options dialog box. 

Creating a Freeform Curve
  Palette:	 Curves > New Curves > New Sketch Curve  

In Alias Design, a curve can also be created without specifying the CVs or edit points. 
You can create a freeform curve by dragging the mouse. However, CVs and edit points 
will be created automatically. To create a freeform curve, choose the New Sketch Curve 

tool from the New Curves flyout in the Curves tab in the Palette; you will be prompted to sketch 
a curve. Press and hold the left mouse button and then drag the cursor in the active window; a 
freeform curve will be created.

To set the parameters of the New Sketch Curve

Figure 2-44  The New Sketch Curve 
Options dialog box

     
tool, double-click on the New Sketch Curve tool; the 
New Sketch Curve Options dialog box will be 
displayed, as shown in Figure 2-44.                                                                              

The Curve Degree and Pivot Position options in this 
dialog box are the same as discussed earlier in the 
New CV Curve  Options dialog box. The rest of the 
options in this dialog box are discussed next.

Tolerance
This edit box is used to specify the closeness of the 
curve created with the path defined by dragging the 
cursor. By default, 3 is displayed in this edit box. 
You can change this value by entering a new value 
in this edit box. Alternatively, you can change the 
tolerance by using the slider bar given on the right 
of this edit box. 

Maximum Spans
This edit box is used to specify the number of spans for the sketched curve. The number of 
spans works in coordination with the degrees of the curve to decide the number of points that 
will be used to generate the curve.
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Figure 2-45 shows the path created by dragging the cursor and Figure 2-46 shows the curve 
created on this path.

Figure 2-46  Curve created on the pathFigure 2-45  Path created by dragging the 
cursor

CREATING PRIMITIVES
The primitives are the building blocks that consist of a single surface or a group of surfaces. 
The primitive tools can be invoked from the Surfaces tab in the Palette or from the Surface 
Tools tab of the Shelves window. The primitives form the first tool of the Surfaces tab. There 
are six primitives in Alias. These are sphere, torus, cylinder, cone, cube, and plane, as shown in 
Figure 2-47. Besides these, circle is also considered as a primitive. The procedure of creating a 
circle primitive has already been discussed and the procedure of creating rest of the primitives 
is discussed next.

Figure 2-47 The Primitives flyout of the Surfaces tab

Creating a Sphere
  Palette:	 Surfaces > Primitives > Sphere  

To create a sphere, choose the Sphere tool from the Primitives flyout of the Surfaces tab 
in the Palette; you will be prompted to specify the position of the sphere. Click in the 
active window; a sphere will be created, as shown in Figure 2-48. To set the parameters 

of the Sphere tool, double-click on the Sphere tool; the Sphere Options dialog box will be 
displayed, as shown in Figure 2-49. The options in the Sphere Options dialog box are discussed 
next.

Sphere Type
The Sphere Type area enables you to select the type of sphere. The radio buttons in this area are 
Surface, Shell Tennis ball, and Shell No-Pole. The Surface radio button is selected by default. 
When you select the Shell Tennis ball radio button, the sphere with the tennis ball profile will 
be created, as shown in Figure 2-50. Select the Shell No-Pole radio button to create a sphere 
without poles, as shown in Figure 2-51. 
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Figure 2-48  Sphere placed in the Perspective 
window

Figure 2-49  The Sphere Options dialog 
box

Figure 2-51  Shell no-pole sphere placed in the 
Perspective window

Figure 2-50  Sphere with the tennis ball 
profile in the Perspective window

Object Degree
The Object Degree area is used to select the degrees of the sphere. By default, the 3 radio 
button is selected. As a result, a sphere with smooth profile will be created. If you select the 1 
radio button, a sphere with a rough profile will be created.

Sweep
You can enter the value of sweep angle of the sphere in the Sweep edit box.

Spans				           
The Spans edit box is used to specify the number of sub-divisions in the sphere. You can also 
change the number of spans by using the slider bar given on right of this edit box. Figure 2-52 
shows the sphere with a sweep angle of 150 degrees and 10 spans.

Note
The Object Degree, Sweep, and Spans areas will be available only when you select the Surface 
radio button in the Sphere Type area.
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Figure 2-52  Sphere with a sweep angle of 
150 degrees and 10 spans

Creating a Torus
  Palette:	 Surfaces > Primitives > Torus  

To create a torus, choose the Torus tool from the Primitives flyout of the Surfaces tab 
in the Palette; you will be prompted to specify the position of the torus. Click in the active 
window; a torus will be created, as shown in Figure 2-53.

To set the parameters of the Torus tool, double-click on the Torus tool; the New Torus Options 
dialog box will be displayed, as shown in Figure 2-54. The options in the New Torus Options 
dialog box are discussed next.

Figure 2-53  Torus placed in the Perspective 
window

Figure 2-54  The New Torus Options dialog 
box 

Sweep
You can enter the sweep angle for the torus in the Sweep edit box.

Size
This area enables you to specify the size of the torus. The radio buttons available in this area 
are discussed next.



Working with Basic Tools					                                      2-27

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Absolute
This radio button is selected by default. With this radio button selected, two edit boxes will 
be available that are discussed next.

Major radius
This edit box is used to enter the value of the major radius of the torus. The major radius 
is the distance between the center and the neutral axis of the torus. You can change the 
major radius by using the slider bar given on the right of the Major radius edit box.

Minor radius
This edit box is used to enter the value of the minor radius of the torus. The minor 
radius is the radius of the cross-section of the torus. You can change the minor radius 
by using the slider bar given on the right of the Minor radius edit box.

Relative                           
If you select this radio button, the Ring

Figure 2-55  The New Torus Options dialog 
box with the Relative radio button selected

  
thickness edit box will be displayed in the 
dialog box, as shown in Figure 2-55.

Ring thickness
This edit box is used to enter the ring 
thickness of the torus. The ring thickness is 
the ratio of the diameter of the cross-section 
to the diameter of the torus. You can change 
the value of the ring thickness by using the 
slider bar given on the right of the Ring 
thickness edit box. The ring thickness 
value varies from 0.00001 to 0.5. If the 
value is 0.5, the torus will be displayed 
without a hole at the center. 

Note
When you work on a tool, the options in the Control Panel change depending upon the tool 
being used.

Creating a Cylinder
  Palette:	 Surfaces > Sphere > Cylinder  

To create a cylinder, choose the Cylinder tool from the Primitives flyout of the Surfaces 
tab in the Palette; you will be prompted to specify the cylinder position. Click in the active 
window; a cylinder will be created, as shown in Figure 2-56.

To set the parameters of the Cylinder tool, double-click on it; the Cylinder Options dialog box 
will be displayed, as shown in Figure 2-57.

The options in the Cylinder Options dialog box are discussed next.
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Figure 2-56  Cylinder created in the Perspective 
window

Figure 2-57  The Cylinder Options 
dialog box

Object Degree
This area is used to specify the degrees of the cylinder.

Caps
The Caps drop-down list is used to specify the number of caps or faces that will close a cylinder. 
Choose the 2 option from this drop-down list to create a cylinder with both ends closed, refer to 
Figure 2-56. Choose the 1 option from this drop-down to create a cylinder with one end closed, 
as shown in Figure 2-58. Choose the 0 option from this drop-down list to create a cylinder with 
both ends opened, as shown in Figure 2-59.

Figure 2-59  Cylinder with no caps at the endsFigure 2-58  Cylinder with a cap at the base

The other options in the dialog box are the same as discussed in the Sphere Options dialog box.

Creating a Cone
  Palette:	 Surfaces > Primitives > Cone  

To create a cone, choose the Cone tool from the Primitives flyout of the Surfaces tab in 
the Palette; you will be prompted to specify the position of the cone. Click in the active 
window; a cone will be created, as shown in Figure 2-60.

To set the parameters of the Cone tool, double-click on it; the Cone Options dialog box will be 
displayed, as shown in Figure 2-61.

The options in this dialog box are the same as those discussed in the Cylinder Options dialog 
box. By default, the 1 option is chosen in the Caps drop-down. Consequently, the cone with the 
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closed base will be placed in the active window, refer to Figure 2-60. If you choose the 0 option 
from this drop-down list, the cone with the opened base will be placed in the active window.

Figure 2-60  Cone with the closed base created in 
the Perspective window

Figure 2-61  The Cone Options dialog 
box

Creating a Cube
  Palette:	 Surfaces > Primitives > Cube  

To create a cube, choose the Cube tool from the Primitives flyout of the Surfaces tab in 
the Pallete; you will be prompted to enter the new position of the cone. Click at the 
required location to specify the point or enter coordinates in the promptline; a cube will 
be created in the window, as shown in Figure 2-62.

To set the parameters of the Cube tool, double-click on the Cube tool; the Cube Options dialog 
box will be displayed, as shown in Figure 2-63. The options in this dialog box are the same as 
those discussed earlier in the Cylinder Options dialog box.

Figure 2-62  Cube created in the Perspective 
window

Figure 2-63  The Cube Options dialog box

Creating a Plane
  Palette:	 Surfaces > Primitives > Plane  

The Plane tool is used to create a square NURBS surface. When you invoke this tool from 
the Primitives flyout of the Surfaces tab in the Palette, you will be prompted to enter 
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the new position of plane. Click in the active window;

Figure 2-64  Plane created in the 
Perspective window

 
a plane will be created in the window at the specified 
location, as shown in Figure 2-64.       
  
To set the parameters of the Plane tool, double-click 
on it; the Plane Options dialog box will be displayed. 
The options in the dialog box are the same as those 
discussed earlier in the Cylinder Options dialog box.

PICK TOOLS
Picking and unpicking of objects play an important 
role in modeling and editing in Alias Design. The tools in the Pick tab are used to select an entity 
or exit an active tool. There are different tools to pick and unpick specific components from the 
active window. You can pick an object by clicking on it or by dragging a pick box around it after 
choosing the required pick tool from the Pick tab. The different pick tools are discussed next.

Picking Objects
  Palette:	 Pick > Pick Object  

You can select an entity drawn in the active window. To do so, choose the Pick Object 
tool from the Pick tab in the Palette; you will be prompted to use the mouse or to enter 
the name of the item to pick. To pick an object, left-click on the particular entity; the 

picked object will be highlighted. Alternatively, drag the mouse to define a pick box around the 
objects to be picked; the objects lying inside and crossing the pick box will be selected.

To set the parameters of the Pick Object tool, double-click on the Pick Object tool; the Pick 
Object Options dialog box will be displayed, as shown in Figure 2-65.

Figure 2-65  The Pick Object Options dialog box

The option in this dialog box is discussed next.

Pick according to layers
The use of the Pick according to layers check box is significant in the case of grouped objects. 
The grouping of objects will be discussed in detail in Chapter 5. To view the usage of this check 
box, group some objects and then assign the individual groups to different layers. Set some layers 
to inactive state. With the Pick according to layers check box selected, you can select the active 
layer objects individually from the active window but you cannot pick the inactive layer objects. 
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If you clear this check box, you can select the whole group. However, you cannot select the 
active layer objects individually. This check box behaves in the same way as the reference layers.

Note
You can also invoke some pick tools from the Marking menus that was discussed in the previous 
chapter.

Tip: To analyze the significance of the Pick according to layers check box, select some 
objects and then choose Edit > Group from the menu bar. You need to group these objects 
under a single node and assign different objects to different layers. Next, press and hold the 
left mouse button on any layer from the layer bar; a flyout will be displayed. From this flyout, 
choose Set state > Inactive; the layer chosen will get inactivated. Similarly, set some more 
layers to the inactive state.

Picking Components
  Palette:	 Pick > Pick Component  

You can pick the components individually by using the Pick Component tool. An object 
consists of many components. For example, a cube has six faces. To pick a single entity, 
invoke the Pick Component tool from the Palette and select the required entity from the 

model in the active window; the selected entity

Figure 2-66  The component filter buttons

 
will be highlighted. On invoking the Pick 
Component tool, the component filter tools will 
be displayed on the left of the promptline 
history, as shown in Figure 2-66. By default, all 
filter tools are displayed in active mode, 
indicating that all these components can be 
picked.

If you do not want to pick a particular component, choose the corresponding filter tool. While 
picking a component from a set of multiple components, the Pick Chooser menu is displayed. 
The Pick Chooser menu lists all the components near the selection point. Choose the required 
component from it.

To set the parameters of the Pick Component tool, double-click on the Pick Component tool; 
the Pick Component Options dialog box will be displayed, as shown in Figure 2-67. The options 
in this dialog box are discussed next.

All
The All area is used to select or clear all the components of an object. The radio buttons in this 
area are discussed next. 

On 
This radio button is selected by default and all component check boxes will be selected. As 
a result, all the components of an object can be picked.
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Figure 2-67  The Pick Component Options 
dialog box

Off
Select the Off radio button to deselect all the components of an object. After clearing all the 
check boxes, you can manually select the individual check boxes to pick the components.

Curves
This check box is selected by default and is used to pick curves from an object.

Surfaces
This check box is used to pick surfaces from an object.

Meshes
This check box is used to pick meshed components from an object.

Sections
This check box is used to pick sectioned components from an object.  

Construction Objects
This check box is used to pick the construction objects such as points, vectors, construction 
planes, and so on from an object.  

Shells
This check box is used to pick shelled components from an object.

Lights
This check box is used to pick lights from an object.
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Others
This check box is used to pick the components such as camera, textures, and so on from the object.

Note
You will learn more about the meshes, sections, construction objects, shells, and other components 
in the later chapters.

Picking Templates
  Palette:	 Pick > Pick Template  

The Pick Template tool is used to pick a template from the active window. If you do not 
want some objects to be modified while modifying other objects, convert them into 
templates. You can convert selected objects into templates by choosing ObjectDisplay > 

Template from the menu bar. The templates are displayed in gray color, and when picked, the 
color changes to pink. 

Picking Edit Points
  Palette:	 Pick > Pick Edit Point  

A curve or a surface consists of number of edit points. The Pick Edit Point tool is used 
to pick the edit points of a curve, surface, and so on. Choose the Pick Edit Point tool 
from the Pick tab in the Palette and then select the required edit point; the picked edit 
point will be highlighted in yellow in the window. 

To set the parameters of the Pick Edit Point tool, double-click on the Pick Edit Point tool; the 
Pick Edit Point Options dialog box will be displayed, as shown in Figure 2-68. The option in 
this dialog box is discussed next.

Figure 2-68  The Pick Edit Point Options dialog 
box 

Use Lasso
A lasso is a freeform curve that is drawn by dragging the mouse. Select the Use Lasso check 
box and draw a freeform curve using the left mouse button around the CVs that you need to 
pick. Note that you cannot pick the edit point by clicking on it if the Use Lasso check box is 
selected. If you clear this check box, you can pick the component by clicking on it or dragging 
a box around it.
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Picking CVs
  Palette:	 Pick > Point Type > Pick CV  

The control vertices are displayed on the hull of the curves and the surfaces. The Pick 
CV tool is used to pick the control vertices of the curves, surfaces, and other components 

of a model. To pick the CV, invoke the Pick CV tool and select the required CV from the active 
window; the picked CV will be highlighted in yellow in the window. To set the parameters of the 
Pick CV tool, double-click on the Pick CV tool; the Pick CV Options dialog box will be 
displayed. The Use Lasso option in this dialog box is the same as discussed in the Pick Edit 
Point Options dialog box.

Picking Hulls
  Palette:	 Pick > Point Types > Pick Hull  

You can pick lines connecting all CVs of a curve, surface, and so on by using the Pick 
hull tool. Choose the Pick hull tool from the Pick tab in the Palette and click on the 

hull; the picked hull will be highlighted in light brown in the active window. To view the hulls 
of a surface, select them from the window and then select the CV/Hull check box from the 
Display area of the Control Panel.

Picking Curves-on-surface
  Palette:	 Pick > Object Type > Pick Curve on Surface 

The curve-on-surface is a curve that does not

Figure 2-69  Curve-on-surface picked using 
the Pick Curve on Surface tool

 
have any CV. You can create curves-on-surface 
by intersecting the two surfaces by projecting 

a curve on a surface, or by using the New 
Curve-on-surface tool from the Curves tab in the 
Palette. To pick these curves, choose the Pick Curve 
on Surface tool and select the curve-on-surface from 
the active window. This curve can be used to trim the 
surfaces. Figure 2-69 shows a curve-on-surface picked 
using the Pick Curve on Surface tool. 

Note
To create curve on a surface using the New 
Curve-on-surface tool, first select the surface 
and then start creating the curve on it. 

Picking all Objects
  Palette:	 Pick > Object Type > Pick All Objects/Lights 

You can select all objects from the active window by using the Pick All Objects/Lights 
tool. To do so, choose the Pick All Objects/Lights tool from the Pick tab in the Palette; 
all objects (curves, surfaces, lights, cameras, templates, meshes, shells, and so on) in the 

window will be selected automatically. The Pick All Objects/Lights tool will be available only in 
the Default workflow. To invoke this workflow, choose Preferences > Workflows > Default from 
the menu bar or press CTRL+1 keys. 
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Picking Objects by Shaders
  Palette:	 Pick > Object Type > Pick by Shader  

You can also select the objects by using shaders. This is significant when you need to 
select/pick the objects that have been assigned the same shades. To assign different shades 
to the objects, first invoke the Visualize workflow by choosing Preferences > Workflows 

> Visualize from the menu bar or press CTRL+4 keys. Choose one of the tabs (Metals, Glass, 
Fabric, and so on) from the Shader Library area of the Control Panel; different shaders will be 
displayed. Double-click on the desired shader from the tab such that the shader gets displayed 
in the Resident Shaders tab of the Control Panel. Next, select the object from the window and 
then choose the Assign Current Shader tool from the Control Panel; the shader will be assigned 
to the selected object. Similarly, assign other shaders to other objects in the window and then 
invoke the Modeling workflow by choosing Preferences > Workflows > Modeling from the 
menu bar or by pressing CTRL+3 keys. To pick the object using the Pick by Shader tool, first 
select the object with the desired shader and then choose the Pick by Shader tool from the Pick 
tab in the Palette; all the objects having the same shader will be picked automatically. If you 
invoke this tool and then select the object with the required shader; all other objects with the 
same shader will be selected automatically. 

Picking Locators
  Palette:	 Pick > Pick Locator  

The locators act as the reference points for measuring the dimensions, deviations, 
annotation, and so on. These locators can be created by using different locator tools 
from the Locators tab in the Palette. These locators can be assigned to different layers, 

and can be picked from the active window by using the Pick Locator tool. You can pick annotation, 
dimension, and deviation locators using this tool. These locators will be discussed in the later 
chapters. 

To set the parameters of the Pick Locator tool, double-click on it; the Pick Locator Options dialog 
box will be displayed, as shown in Figure 2-70. The options in this dialog box are discussed next.

Figure 2-70  The Pick Locator Options dialog box

Measurement 
This check box is selected by default and is used to pick the locators that measure distance, 
angle, radius, and diameter.
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Deviation
This check box is also selected by default and is used to pick the locators that determine the 
close point deviation, deviation between curves, deviation between surfaces, deviations between 
a curve and a surface, and deviation between a mesh and a surface.

Others
This check box is also selected by default and is used to pick the locators that determine the arc 
length and the curvature of a curve.

Picking Visible Objects
  Palette:	 Pick > Pick Visible  

You can use the Pick Visible tool to pick the surface that is hardware or diagnostic 
shaded. When the object is not shaded, this tool does not work. Select the shaded surface 
and then invoke the Pick Visible tool; the surface will get highlighted.

Picking Surface Chains
  Palette:	 Pick > Surface Chain  

You can use the Surface Chain tool to pick the surface that is G0 or G1 continuous with 
edges until the specified tolerance value for continuity does not reach.  

To set the parameters of this tool, double-click on this tool; the Surface Chain Control dialog 
box will be displayed, as shown in Figure 2-71.

Figure 2-71  The Surface Chain Control dialog box

The options in this dialog box are discussed next.

Edge Continuity 
This drop-down list has two options: G0 and G1. Select the G0 or G1 option to select all surfaces 
having position or tangent continuity, respectively, with native surfaces.   

Tolerances
The options in this area are used to define the tolerances for the selection process.
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Use Constructions
Select this check box to apply the continuity tolerances that you have specified in Preferences  
> Construction Options > Tolerances > Continuity.

Maximum Gap G0
This edit box is used to specify the maximum gap allowed between two surfaces for the 
system to consider them as connected. Default value in this edit box is 0.0100. The gap 
value ranges from 0.0000 to 1.0000. Alternatively, you can set the gap value with the help 
of the slider bar available on the right of this edit box.

Normal Angle G1
This edit box is used to define the maximum angle allowed between two surface normals 
for the system to consider them as pointing in the same direction. Default value in this edit 
box is 0.1000 and its value can vary from 0.0000 to 1.0000. Alternatively, you can set this 
angle value by using the slider bar available on the right of this edit box.

Topology Distance
This edit box is used to specify the distance value that is used to calculate the adjacency of 
one surface with another surface.

Picking Nothing
  Palette:	 Pick > Pick Nothing  

Sometimes you may want to unpick an object that you no longer need. In such cases, you 
can use the Pick Nothing tool to unpick the picked object. Choose the Pick Nothing tool 
from the Pick tab in the Palette; the picked objects will be unpicked and the tool that was 
used before invoking the Pick Nothing tool will remain activated. 

Note
You can also unpick a picked object by selecting it again. 

TRANSFORM TOOLS
The transform tools are used to dynamically control the shape and development of the final 
model. The transform tools are available in the Transform tab of the Palette. The primary 
transform tools such as Move, Rotate, and Scale are also available in the Shelves window and 
the Marking Menus. You can use the transform tools freely in the orthographic window. In the 
Perspective window, you can use these tools normal to the X, Y, and Z axes only. The various 
transform tools are discussed next.

Moving an Object
  Palette:	 Transform > Move  

You can dynamically move or translate an object to the desired position by using the 
Move tool. You can pick the object before or after invoking this tool. On invoking this 
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tool, you will be prompted to specify the new position in relative or absolute units in the 
promptline. Enter the new position in the promptline or drag the object to move it dynamically 
to a new position. While moving the object in the Perspective window, the left, middle, and 
right mouse buttons are used to move the object in the X, Y, and Z directions, respectively. The 
dynamic display boxes showing the current position of the object in the corresponding direction 
will be displayed in all windows. This position keeps changing as you drag the cursor in the 
corresponding direction. In orthographic windows, these dynamic display boxes will be displayed 
only when you drag the cursor with the middle and the right mouse buttons. In orthographic 
windows, the left mouse button is used to move the object in desired direction, while the middle 
and right mouse buttons are used to move the object in horizontal and vertical directions, 
respectively. Figure 2-72 shows a cylinder and a sphere in the Front window and Figure 2-73 
shows the sphere moved vertically upward in the same window.

Note
While using a transform tool, keep the cursor away from the objects to prevent the selection of  entities.

Tip: While moving an object, if you press the ALT key, the cursor will snap to the grids. 

Figure 2-73  Sphere moved vertically upwardFigure 2-72  A cylinder and a sphere in the 
Front window

To set the parameters of the Move tool, double-click on the Move tool; the Move Options dialog 
box will be displayed, as shown in Figure 2-74. The options in the Move Options dialog box 
are discussed next. 

Type
This area is used to specify the coordinate system for moving an object. The two radio buttons 
in this area are discussed next.

Global
This radio button is selected by default and is used to move an object in the global X, Y, 
and Z coordinate system. 
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Local
Select this radio button to move an object in the local X, Y, and Z coordinate system. The 
local coordinate system of the object is located at its pivot point. If there are more than one 
object in the scene, you can move the selected object with respect to its local coordinate 
system. Figure 2-75 shows the circle moved with respect to its local coordinate system.

Figure 2-75  Circle moved in the local coordinate 
system

Figure 2-74  The Move Options dialog box

Rotating Objects
  Palette:	 Transform > Rotate  

You can rotate an object dynamically around the pivot point by using the Rotate tool. 
You can pick the object before or after invoking this tool. On invoking this tool, you will 
be prompted to specify the rotation angle. Enter the rotation angle in the promptline or 

rotate the object dynamically in the window. Use the left, middle, and right mouse buttons to 
rotate the object around the X, Y, and Z axes in any window, respectively. Figure 2-76 shows a 
cube before rotation and Figure 2-77 shows the same cube rotating about the X-axis.

Figure 2-77  Cube rotating about the X axisFigure 2-76  Cube before rotation

To set the parameters of the Rotate tool, double-click on it; the Rotate Options dialog box will 
be displayed, as shown in Figure 2-78.

The options in the Rotate Options dialog box are discussed next.
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Figure 2-78  The Rotate Options dialog box

Type
This area is used to specify the type of coordinate system for rotating an object. The three radio 
buttons in this area are discussed next.

Global
This radio button is selected by default and is used to rotate the object by incrementing its 
Euler rotation angles. The Euler rotation angles are used to specify the orientation of the 
rigid bodies. In this type of rotation, the rotation is first done to Z, then to Y, and finally to 
X. In this way, the rotation about the X-axis depends on the rotation about the Y and Z axes.

Local
Select this radio button to rotate the object about the local X, Y, and Z coordinate system. 
The local coordinate system of the object is located at its pivot point. If there are more 
than one object in the window, you can rotate the selected object with respect to its local 
coordinate system.

Universe
Select the Universe radio button to rotate the object about the world X, Y, and Z coordinate 
system.

Vector
Select the Vector radio button to create a vector to rotate the object about the specified 
rotation axis. 

Scaling an Object
  Palette:	 Transform > Scale  

You can dynamically scale the object uniformly or non-uniformly along the axes by using 
the Scale tool. You can pick the object before or after invoking this tool. On invoking 
this tool, you will be prompted to enter the scale. Enter the scale in the promptline or 

drag the mouse to scale the object dynamically in the window. To scale the object uniformly, 
drag the cursor with the left mouse button in the orthographic or the Perspective window. The 
use of different mouse buttons in different windows for scaling the objects is listed in the table 
given next.



Working with Basic Tools					                                      2-41

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Mouse button Window Direction of scaling

Left Top, Left, Back 
and Perspective

Uniformly along the X, Y, and Z axes

Middle

Top and Left X-axis

Back Y-axis

Perspective Uniformly along the X, Y, and Z axes

Right

Left and Back Z-axis

Top Y-axis

Perspective Uniformly along the X, Y, and Z axes

Scaling Objects Non-proportionally
  Palette:	 Transform > Non-p Scale  

You can scale the object non-proportionally along the three axes by using the Non-p 
Scale tool. You can pick the object before or after invoking this tool. On invoking this 
tool, you will be prompted to specify the scale factor along the X, Y, and Z directions. 

Enter the scale factors in the promptline or drag the mouse buttons to scale the object dynamically 
in the window. The use of different mouse buttons for scaling the objects non-proportionally is 
given in the following table.

Mouse button Window Direction of scaling

Left

Top X and Y axes

Back Y and Z axes

Left X and Z axes

Perspective X-axis

Middle
Top and Left X-axis

Back and Perspective Y-axis

Right
Top Y-axis

Left, Back, and Perspective Z-axis

Figure 2-79 shows a cube before scaling and Figure 2-80 shows the same cube scaled 
non-proportionally along the X-axis.

Transforming an Object
  Palette:	 Transform > Transform   

The Transform tool is used to scale, move, and rotate an object. On invoking this tool, 
you will be prompted to pick/unpic an object. When you select the object, a transform 
manipulator will be displayed at the pivot point of the selected object, as shown in 

Figure 2-81. Now, you can scale, move, and rotate the selected object with the help of transform 
manipulator. 
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Figure 2-79  Cube before scaling Figure 2-80  Cube scaled non-proportionally 
along the X-axis

To set the parameters of the Transform tool, double-click on this tool; the Universal Transform 
Option dialog box will be displayed, as shown in Figure 2-82. 

Figure 2-82  The Universal Transform 
Options dialog box

Figure  2-81 Tranform manipulator

The options in this dialog box are discussed next.

Move
This check box is selected by default. Select this check box if it is not selected to move the object 
with transform manipulator. You can move the object with the help of cone-shaped handles 
of the manipulator. If you clear this check box then cone shaped handles will disappear from 
manipulator.

Rotate
This check box is selected by default. Select this check box if it is not selected to rotate the 
object with transform manipulator. You can rotate the object with the help of spherical handles 
of the manipulator. If you clear this check box, the spherical handles will disappear from the 
manipulator.
 
Scale
This check box is selected by default. Select this check box if it is not selected to scale the object 
with transform manipulator. You can scale the object with the help of cube-shaped handles of 
the manipulator. If you clear this check box, the cube shaped handles will disappear from the 
manipulator.
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Setting the Pivot Point
  Palette:	 Transform > Local > Set Pivot  

The pivot point plays an important role in

Figure 2-83  Torus showing the pivot point

 
various transforming operations such as 
moving, rotating, scaling, and so on. When 

you change the position of a pivot point, the 
transform operations will start about the new position 
of the pivot point. The new position of the pivot point 
will act as the starting point for any transform 
operation. The Set Pivot tool is used to change the 
position of the pivot point of the picked object. When 
you pick an object, the pivot point will be highlighted 
in green, as shown in Figure 2-83. When you choose 
the Set Pivot button, you will be prompted to enter 
a new position of the pivot point. Once you enter the new position, the pivot point will shift to 
it. You can also specify a new position for the pivot point by dragging the cursor in the active 
window. For example, a cylinder with the pivot point placed at the center is shown in Figure 2-84. 
You can change the position of the pivot point from the center to the top cap of the cylinder 
using the Set Pivot tool, as shown in Figure 2-85.

Figure 2-85  Pivot point shifted to the top cap Figure 2-84  Pivot point at center of the 
cylinder

The functions of different mouse buttons in changing the position of the pivot point is given 
in the following table:

Mouse button Window Movement direction

Left
Top, Left, and Back Free to move in any direction

Perspective X-axis

Middle
Top and Left X-axis

Back and Perspective Y-axis

Right
Left, Back, and Perspective Z-axis

Top Y-axis
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To set the parameters of the pivot point, double-click on the Set Pivot tool; the Set Pivot Options 
dialog box will be displayed, as shown in Figure 2-86.

There are two types of pivots in an object, rotation and scaling. The rotation pivot is displayed 
as a circle with a dot at the center and the scaling pivot is displayed as an asterisk (*). If you pick 
an object, these pivots will be displayed together. You can separate these pivots by changing the 
parameters in the Set Pivot Options dialog box. Figure 2-87 shows a sphere with the rotation 
and scaling pivots separated from each other.

Figure 2-87  Sphere showing the rotation and 
scaling pivots separated from each other

Figure 2-86  The Set Pivot Options dialog 
box

The options in the Set Pivot Options dialog box are discussed next.

Rotation
This check box is selected by default and is used to change the position of the rotation pivot. To 
change the position of the rotation pivot without affecting the scaling pivot, clear the Scaling 
check box. Next, choose the Go button; you will be prompted to specify the new position of 
the pivot point. Enter the new position in the promptline or drag the cursor to the required 
position; the rotation pivot will be shifted to the new position.

Scaling
This check box is also selected by default and is used to change the position of the scaling pivot. 
To change the position of the scaling pivot without affecting the rotation pivot, select the Scaling 
check box if not selected and clear the Rotation check box. Next, choose the Go button; you 
will be prompted to enter the new position of the pivot point. Enter the new position in the 
promptline or drag the cursor to the required position; the scaling pivot will be shifted to the 
new position. 

Move Selection Handle
The Move Selection Handle check box is selected by default and allows you to move the selection 
handle and the pivot point simultaneously. This check box will be available only when you select 
the Rotation check box. If you clear the Move Selection Handle check box, you can move the 
pivot point and the selection handle separately. 
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Creating Array of an Object
  Palette:	 Transform > Arrays > Array  

You can create an array of objects, either linearly or radially by using the Array tool. To 
create an array of an object, invoke the Array tool from the Arrays flyout of the Transform 
tab in the Palette; you will be prompted to select object(s) to array. Select the object(s); 

the Build button will be displayed at the lower right corner of the active window. Choose the 
Build button; the array will be created. Figure 2-88 shows a linear array created in XZ plane.

To set the parameters of the Array tool, double-click on the Array tool; the Array Control dialog 
box will be displayed, as shown in Figure 2-89.

Figure 2-88  The linear array created using 
the Array tool

Figure 2-89 The Array Control dialog box

The options in the Array Control dialog box are discussed next.

Plane
This option is used to specify the plane on which you want to create an array. Select the XY, XZ, 
or YZ radio button to specify the plane.

Mode
This option is used to specify the mode of array. You can create linear or radial array.
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Linear
This radio button is selected by default and is used to create an array consisting of rows and 
columns arranged in a rectangular pattern. When you select the Linear radio, button the 
related options are displayed. These options are discussed next.

Axis 1: The options in this section are used to determine the direction of array. This defines 
array in the horizontal direction. The Number edit box is used to specify the number of 
duplicates in each direction. The Spacing edit box is used to specify the distance between 
the rows and columns in the current units. The Offset edit box is used to specify the offset 
for each row (column) in the array by the distance from the previous row (column). The 
Scale edit box is used to specify the relative scale factor applied to the original object to 
produce the last duplicate in each row or column. You can select the Stagger check box to 
offset the alternating rows (columns) to half the specifying value. Select the Mirror check 
box to mirror the pattern in the other axis.

Axis 2: The options in this section are same as in Axis 1. The Axis 2 options are used to 
define array parameters in vertical direction.

Radial
By selecting this radio button, you can create an array arranged radially around the original 
object. After selecting the Radial radio button, the following options are displayed:

Radial: The options in this section determine the direction of the array radially. The options 
in this section are same as the options in the Axis 1 option. The options in this section 
control the direction of the array along the circumference. 

Angular: The options in this section determine the angular parameters of radial array. Some 
options in this area are same as the options in the Radial area. The remaining options are 
discussed next. The Angle option is used to specify the angle between the two radial columns 
of the array to be created. When you select the Fit to Circle option, the Angle option will 
get disabled and the array will be created at equal angle. For example, if the Number is 5, 
the Angle is set to be 72.

Control Options: The Auto Update check box is selected by default and is used to update 
the array if any changes are made in data in the control window. The Create History check 
box is selected by default and is used to save the history of the array so that it can be modified 
later. The Rotate Duplicates option is available in the Radial mode only. When you select 
this option, the duplicates will rotate around their local pivot by a relative value of angle 
with respect to their orientation in the previous column. The Scale Position option is used 
to scale the distance between duplicates along with their size when the Scale option is set 
other than 1.0. If the value of scale is greater than 1.0, then the overlapping will be reduced. 
The Grow Radially option is available in the Radial mode only. When selected, the number 
of duplicates increases as the radius of its row is increased. This technique helps you create 
the appearance of concentric circles rather than spokes. The Center Original check box 
is selected by default and is used to keep the selected object at the center and copies are 
created radially around it. When the Center Original check box is not selected, the duplicates 
are created around a point beside the original object based on the spacing value specified.



Working with Basic Tools					                                      2-47

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Creating Path Array of an Object
 Palette:	 Transform > Arrays > Path Array  

You can create duplicate of one or more objects and place the copies at equal distances 
along one or more curves to create a path array. To create path array of an object, invoke 
the Path Array tool from the Arrays flyout in the Transform tab of the Palette; you will 

be prompted to select object(s) to duplicate. Select the object(s); the Build button will be displayed 
at the lower right corner of the active window. Choose the Build button; you will be prompted 
to select the target curve. Select the target curve; the path array will be created, as shown in the 
Figure 2-90.

Figure 2-90  Path array of an object along a target curve

To set the parameters of the Path Array tool, double-click on the Path Array tool; the Path 
Array dialog box will be displayed, as shown in the Figure 2-91. The options in this dialog box 
are discussed next.

Specify
This drop-down list has two options: Spacing and Number. These options are used to determine 
the number of duplicates to be created along the target curve.

Spacing: The Spacing edit box is used to define distance between consecutive duplicates. 
The Start edit box specifies where the duplicates start along the curve. Start value ranges 
from 0 to 1. These values can also be set by using the range manipulators on the path curve. 
The End edit box specifies where the duplicates end along the curve. End value ranges from 
0 to 1. These values can also be set by using the range manipulators on the path curve. The 
Scale edit box specifies a relative scale factor applied to the first duplicate to produce the 
last duplicate. The sizes of intermediate duplicates are linearly interpolated.

Number: The Number edit box defines the number of times the duplicates are to be 
created. The remaining parameters are same as in the Spacing option.

Position
The options in this area are used to specify offset values for duplicating the object along their 
local X, Y and Z axes.  
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Rotation                                                    

Figure 2-91  The Path Array dialog box

The options in this area are used to specify rotation 
values for rotating the object along their local X, Y and 
Z axes. 

Incremental Rotation
The options in this area are used to specify values for 
rotating the duplicates along their own local axes (X, Y 
and Z) by a relative angle with respect to the previous 
duplicate. This produces a twisting effect along the path.

Control Options
The options in this area are used for auto updating, 
creating history, and so on. The options in this area are 
discussed next.

Orientation
The Orientation drop-down list specifies the 
orientation for all sequences of array with respect 
to the original object. By default, the None option 
is selected in this drop-down list. When the None 
option is chosen, there will be no change in 
orientation of array. When you choose the Tangent 
option from this drop-down list, all the sequences 
will be rotate based on the tangent of the input 
curve at the point where the object is being placed. 
The Normal option aligns the local X axis of each 
duplicate with the tangent of the target curve at the 
position of the duplicate

Auto Update
The Auto Update check box is selected by default and is used to update the path array if 
any change is made in data in the control window.

Create History
The Create History check box is selected by default and is used to save the history of the 
path array so that it can be modified later.

Chain Select
If this check box is selected, then on selecting a curve all other curves that are tangent 
continuous with the selected curve will be selected.

Range Fit
Select the Range Fit option to ensure that the duplicates fit the entire length of the curves 
specified by the start and end positions of the curve. This action sometimes causes the 
spacing changes. This option will be available only when the Spacing option is selected 
from Spacing drop-down list.
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Creating Surface Array of an Object
 Palette:	 Transform > Arrays > Surface Array  

In Alias, you can duplicate one or more objects and place the copies at equal distances 
to create arrays on surface. To create surface array of an object, invoke the Surface Array 
tool from the Arrays flyout in the Transform tab of the Palette; you will be prompted to 

select object(s) to duplicate. Select the object(s); the Accept button will be displayed at the lower 
right corner of the active window. Choose the Accept button; you will be prompted to select the 
target surface. Select the target surface; the surface array will be created, as shown in the 
Figure 2-92.

Figure 2-92  Surface array of an object created 
along the target surface

To set the parameters of the Surface Array tool, double-click on the Surface Array tool; the 
Surface Array dialog box will be displayed, as shown in Figure 2-93. The options in this dialog 
box are discussed next.

Position
The parameters in this area are used to offset the duplicates in the N, U, and V directions along 
their own local axes (X, Y, and Z).

Rotation
The parameters in this area are used to rotate the duplicates along their own local axes (X, Y, 
and Z).

Primary
The options available in this area are discussed next.

Specify
This drop down list is used to specify options for duplicating the object along the target 
surface. It has two options: Spacing and Number. By default, the Number option is selected.

Number                                                       
The Number option determines the number of times a duplicate will be created. On selecting 
the Start option, the initial point for the creation of duplicates is specified in the primary 
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direction of the surface. This can be adjusted in

Figure 2-93  The Surface Array dialog box

 
the control window or with in-canvas range 
manipulators. Start values can range from 0 to 
1. On selecting the End option, the end point 
for the creation of the duplicates is specified in 
the primary direction of the surface. This can be 
adjusted in the control window or with in-canvas 
range manipulators. End values ranges from 0 
to 1. The Scale option is used to specify the 
relative scale factor for creating the last duplicate 
with respect to the first duplicate. The sizes of 
intermediate duplicates are interpolated. The 
Offset option is used to specify offset distance by 
which each row in the array will be offset from 
its preceding row.

Stagger
If you select this check box then each row is offset 
by half of the spacing value to create a stagger 
effect.

Rotation
When you select this option, the incremental 
rotation in the X, Y and Z will be displayed to 
rotate the duplicates.

Spacing
The Spacing option will be available only 
when you select Spacing from the Specify 
drop-down list. This defines the distance between 
the consecutive duplicates. The remaining 
parameters are same as in the Number option.

Range Fit
This option ensures that the duplicates fit into 
entire length of the target surface specified by 
the Start and End positions. This option will be 
available only when Spacing is selected from the 
Spacing drop-down list.

Secondary
The options in this area are discussed next.

Direction
If the U radio button is selected, the objects will 
be laid out along U isoparms. If the V radio 
button is selected, the objects will be laid out along V isoparms. If the target is a U or V 
isoparm, the U or V direction will be selected by default and is dependent on the primary 
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direction. Note that the Perpendicular radio button creates the secondary direction 
perpendicular to the primary direction.

Side
This option is used to create the secondary direction of the array on the Positive, Negative, 
or Both sides of the primary input. The Positive End option specifies the start and end 
points for the secondary direction duplicates on the positive side of the primary input. The 
value for the Positive End ranges from 0 to 1. The Negative End option specifies the start 
and end points for the secondary direction duplicates on the negative side of the primary 
input. The value for the Negative End ranges from 0 to 1.

Control Options
 The options in this area are discussed next.

Orientation
The options in the Orientation drop-down list are already discussed in the Path Array tool.

Auto Update
The Auto Update check box is selected by default. As a result, the surface array is updated 
automatically if any changes are made to the data in the control window.

Create History
This check box is selected by default. As a result, the history of the surface array is saved 
automatically so that it can be modified later.

Chain Select
If you select this check box, then on selecting a curve, all the curves that are tangent con-
tinuous with the selected curve will be selected.

Setting the Pivot Point at the Center
  Palette:	 Transform > Local > Center Pivot  

Sometimes, you may need to position the pivot point at the center of an object. This can 
be done by using the Center Pivot tool. To place the pivot point at the center, select the 
object from the active window. Next, hold the left mouse button on the Set Pivot tool; a 

flyout will be displayed. Choose the Center Pivot tool from this flyout; the pivot point will be 
placed at the center of the object. This tool does not effect the position of the selection handle.
  
To set the parameters of the Center pivot tool, double-click on the Center Pivot tool; the Center 
Pivot Options dialog box will be displayed, as shown in Figure 2-94.

The Rotation and the Scaling check boxes are selected by default and they allow you to place the 
rotation and scaling pivots at the center of the object simultaneously. If you clear the Rotation 
check box, only the scaling pivot will be placed at the center of the object. If you clear the Scaling 
check box, only the rotation pivot will be placed at the center of the object. You cannot clear 
both check boxes simultaneously.
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Figure 2-94 The Centre Pivot Options dialog box

Rotating the Local Axes of the Object
  Palette:	 Transform > Local > Set Local Axes  

You can set (rotate) the local axes of an object. To rotate the local axes of an object, select 
an object and then choose the Set Local Axes tool from the Local flyout of the Transform 
tab in the Palette; the local axes will be displayed on the selected object. Next, drag the 

cursor to any of the windows to rotate the local axis. The direction of rotation depends on the 
active window in which you are dragging the cursor. Figures 2-95 shows the local axes of a cube 
and Figure 2-96 shows the rotated local axes. 

Figure 2-96  Rotated local axes of a cubeFigure 2-95  Local axes of a cube

To set the parameters of the Set Local Axes tool, double-click on it; the Set Local Axes Options 
dialog box will be displayed, as shown in Figure 2-97. The options in this dialog box are discussed 
next.

Method 
The options in this area are used to specify the ways in which you can set local axes. These 
options are discussed next.

Interactive
This radio button is selected by default. As a result, you can drag the local axes of the object(s) 
to rotate the local axes relative to the world axes. 

Object
This radio button is used to match the local axes of an object with the local axes of another 
object. While using this radio button, you need to select the object to which you want the 
selected object’s local axes to be matched with.
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Figure 2-97  The Set Local Axes Options dialog box

Reset
This radio button is used to reset the local axes to match the orientation of World Coordinate 
System.

Resetting the Transformation of Objects
  Palette:	 Transform > Zero Transforms  

Sometimes, you may need to reset the transformation (translation, scaling, or rotation) 
of the objects such that the new position of the objects become their origin or zero points. 
After resetting the transformation, the objects lose or forget their transformation 

information. To reset the transformation of the object, choose the Zero Transforms button from 
the Transform tab in the Palette; the transformations applied to the selected object will be reset. 
To view the effect of the Zero Transforms tool, select the component and then invoke the 
Information Window dialog box before and after resetting the transformation. You will notice 
that the transformations such as translation, rotation, and scale will be reset to their original 
values after applying the zero transformation.

Note
If you apply zero transformation to lights, camera, and 3D textures, the objects will be rendered 
incorrectly.

SHADING OBJECTS IN VIEW WINDOWS
After creating a model in Alias Design, you can shade it to give more realistic look. There are 
two methods to apply shades to model. These methods are discussed next.

Diagnostic Shading
You can give a realistic look to a model by using diagnostic shading. Shading an object depends 
a lot on tessellation. Tessellation is the subdivision of geometry into regular or irregular 
non-overlapping polygons. Polygons form a pattern that enables you to render an object with 
more accuracy as well as shade it easily. More the number of subdivisions of geometry (tessellation), 
better will be the shade of the object. Some natural examples of tessellation are honeycomb, 
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scales of fish, snake, pineapple, and so on. To shade an object,

Figure 2-98  The Diagnostic 
Shade dialog box

 
choose ObjectDisplay > Diagnostic Shading from the menu bar; 
the Diagnostic Shade dialog box will be displayed, as shown in 
Figure 2-98. Next, select the object and then choose the required 
tool from the Diagnostic Shade dialog box to shade the object. 
The options in the Diagnostic Shade dialog box are discussed 
next.

Tolerance
This edit box is used to control the accuracy of surface tessellation 
when you choose the Fast option from the Tessellator area.
 
Tessellator
This area is used to specify the method of tessellation. By default, 
the Fast button is chosen in this area. As a result, the object will be 
tessellated more quickly but with less accuracy. To make an object 
tessellate accurately, press and hold the left mouse button on the 
Fast button; a flyout will be displayed. Choose the Accurate button 
from the flyout; the object will tessellate slowly but accurately.

Shading Off
Choose this tool to turn off the shading. On choosing this tool, the object will be displayed 
in the wireframe mode.

Multi Color
Choose this tool to shade the object with a specific color. You can specify the color by 
choosing this tool and then picking a color from the Color swatch box that will be displayed 
when you click on the arrow of the color option of the Diagnostic Shade dialog box. You 
can also change the specularity (reflectivity), transparency, light intensity, and so on.

Random Color
Choose this tool to shade the objects with different colors randomly. You can control color 
saturation, specularity, transparency, and light intensity of shaded objects by choosing 
this tool and then selecting the options that are displayed at the bottom of the Diagnostic 
shade dialog box. 

Horizontal/Vertical (Zebra)
Choose this tool to display the horizontal and vertical highlights while shading objects. 
Highlights allow you to find the surface flaws, mismatched tangency between the surfaces, 
and so on. You can display the highlights horizontally or vertically by choosing this tool 

and then selecting the required options that are displayed at the bottom of the Diagnostic Shade 
dialog box. You can specify the rate at which the highlights, horizontal or vertical, will repeat 
themselves. You can also specify the transparency of the highlights.

Surface Evaluation
Choose this tool to shade an object using the surface evaluation options such as deviation 
map, deviation ramp, draft angle, and contact analysis. The surface evaluation tools will 
be discussed in Chapter 13. 
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User Defined Texture
Choose this tool to shade an object with your own defined map textures. You can specify 
the mapping texture by choosing this tool and then selecting the required options displayed 
at the bottom of the Diagnostic Shade dialog box. You can also specify the transparency 
of the texture and the rate at which the texture will be repeated.

Light Tunnel
When the cylindrical light beam reflections fall on the surface of an object, they produce 
a shading effect.

Clay with Ambient Occlusion
Choose this tool to apply the low reflection clay color on the model. You can change the 
model clay color from the Color swatch box that will be displayed when you click on the 
arrow of the color option area of the Diagnostic Shade dialog box.

Isophote
When you choose this tool, bright lines are displayed on the surface of the object. If any 
surface discontinuity defect is present on the object surface, it can be recognized easily 
by applying this shade using the Isophote tool. The color of the surface of the object and 

of the bright lines can be changed with the help of edit boxes in the Diagnostic Shade dialog 
box.

Apart from the tools discussed above, the Diagnostic Shade dialog box has four more tools: 
Visual State 1, Visual State 2, Visual State 3, and File State. You can create shading using these 
tools and then save them to user-preferences. Later on, you can retrieve the saved visual states. 
You can specify the shading settings to be assigned to a Visual State tool for an object in the 
view window. To do so, select the object and then choose a visual state tool. Next, click on the 
arrow given below the visual state tool; the options corresponding to the tool chosen will be 
displayed. The Shade Setting and Environment Editor options allow you to change the hardware 
shading and environment settings respectively of the objects. You can also save a setting to user 
preferences by choosing the Save To Prefs option. If you choose the File State tool, the Save 
To Prefs tool will not be available. You can retrieve the settings of the last active environment 
by choosing the File State tool.

Hardware Shading
Hardware shading is used to shade objects to make them appear more realistic. You can even 
render the models that are shaded by using hardware shading. Hardware shading also enables 
you to toggle between the wireframe mode and the render preview views of the model. To shade 
objects with hardware shading, choose WindowDisplay > Hardware Shade from the menu 
bar; the objects will be shaded with the default hardware shade. You can also set the options 
for hardware shading. To do so, click on the box on the right of the Hardware Shade option; 
the Hardware Shade dialog box will be displayed, as shown in Figure 2-99. The options in this 
dialog box are discussed next.

Use Embedded File Settings
Select this check box to shade the objects with the hardware shade settings that were saved with 
the earlier file.
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All Windows
This check box is selected by default and is used to shade

Figure 2-99  The Hardware Shade 
dialog box

 
the objects in all the view windows.

All Geometry
This check box is also selected by default and is used to shade 
all geometry in the view windows. Clear this check box to 
shade the active (selected) objects only.

Shading Method
The Shading Method area is used to specify the shading 
method used for shading the objects. By default, the 
Per vertex tool is chosen in this area, which helps in fast 
approximation of the surface at the time of modeling. If you 
choose the Per pixel tool from the Shading Method area, 
the objects will be shaded by using Raycaster rendering. 
Raycaster rendering will be discussed in Chapter 12. To 
shade the model or object with the Per pixel tool chosen, 
you need to meet the graphic card requirement. 

Tessellator
This area is used to specify the method of tessellation. The 
options in this area are the same as those discussed in the 
Tessellator area of the Diagnostic Shade dialog box.

Quality
This area is used to control the accuracy of tessellation while shading the surfaces. You can specify 
the quality of tessellation as high, low, or medium by choosing the corresponding button from 
the Quality area. You can also specify a user-defined tessellation for shading by choosing the 
User Defined button from this area. In this case, you need to specify the tolerance manually.

Texture Resolution
If you are using textures in shading the objects, you can use the Texture Resolution area to speed 
up the calculations in hardware rendering. You can specify 128, 256, 512, 1024, and 2048 as the 
texture resolution by choosing the corresponding button from this area. You can turn off the 
texture resolution while rendering the object by choosing the Off button from this area. If you 
specify the texture resolution as 512, the texture will be rendered approximately to 512 x 512 
pixels square. Note that the size of texture map should not be greater than the rendered texture. 

Light Source
The Light Source area can be used to specify the source of light that will be used in shading 
the objects. You can use all lights, default lights, selected lights, and so on in the view window 
by choosing the corresponding button from this area.
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Self Shadows
Select this check box to add additional information about the spatial relationships between the 
objects when they cast shadow on themselves. These self shadows appear different with different 
buttons of the Light Source area.

Auto update
This check box is selected by default and is used to automatically update the modifications done 
in the view windows.

Enable Environment Effects
This area can be used to specify the parameters related to the environment. The options in this 
area are discussed next.

Use Environment
This check box is selected by default and enables you to use the environment in the background. 
The environments will be available in the environments tab that will be displayed if you invoke the 
Visualize workflow. These environments help you apply reflection of model in the environments.

Show Background
Select this check box to display the background while shading the object.

Ground Plane
Select this check box to display the ground plane, ground plane shadow, and ground plane 
reflections in the view window. 

Shader Glow
Select this check box to self-illuminate the objects. On selecting this check box, the shader glows 
will illuminate the objects without affecting the environment or other surrounding objects. 
Shader glows cannot be viewed in reflections or ground planes. 

Edit Environment
Choose this tool to invoke the Environment editor that can be used to edit the environment 
used to shade the objects.

Optimize during Tumble
This area can be used to optimize certain parameters related to the object during hardware 
shading. The options in this area can be used to optimize self shadows, shader glows, and ground 
plane reflections of the objects while doing camera operations such as track, tumble, and dolly. 
When you select a check box, the respective parameters of the object get approximated and are 
updated when you release the mouse. 

Shade Off
Choose this tool to turn off the hardware shading of the objects.
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Shade On
Choose this tool to turn on the hardware shading of the objects.

Note
1. You will learn how to shade objects in the tutorials of the later chapters. In some tutorials, 
you will shade models by using the Diagnostic Shading option, and in others, you will use the 
Hardware shade option.

2. An alternative method of invoking the Hardware Shade dialog box is by choosing the Shade 
Setting option from the options available on choosing any of the visual states or the File State 
buttons from the Diagnostic Shade.  

TUTORIALS

Tutorial 1

In this tutorial, you will create the 3D model of a globe, as shown in Figure 2-100. After creating the 
model, you will shade it for giving it a realistic look.		        (Expected time: 30 min)

Figure 2-100  3D model of a globe

The following steps are required to complete this tutorial: 

a.	 Start Alias Design and then start a new wire file.
b.	 Change the grid settings of the window.
c.	 Create the base of the globe by using the Cylinder tool.
d.	 Scale the base of the globe by using the Non-p Scale tool.
e.	 Create the stand of the globe by using the Cylinder tool.
f.	 Scale the stand of the globe by using the Non-p Scale tool. 
g.	 Create the ring of the globe by using the Torus tool and change its parameters.
h.	 Create the globe by using the Sphere tool. 
i.	 Create the axial rod by using the Cylinder tool.
j.	 Rotate the axial rod by using the Rotate tool.
k.	 Shade the model by using the Diagnostic Shading option.
l. 	 Save the model and exit.
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Starting a New Wire File
1.	 Start Autodesk Alias Design 2016 by double-clicking on its icon on the desktop of your 

system.
	
	 When you start Alias Design, the perspective window is displayed on the screen by default. 

You can change the display of the window by choosing the Layouts menu from the menu 
bar and then selecting the required window. In this tutorial, you will use all these windows 
for modeling.

Changing Grid Settings
	 Next, you need to change the units and grid settings of the windows. From this tutorial 

onward, set units to millimeters and the grid spacing to 100 unit.

1.	 Choose Preferences > Construction Options from the menu bar; the Construction Options 
dialog box is displayed. 

2.	 Click on the down-arrow on the left of the Units option; the different types of units are 
displayed. Click on the Linear down-arrow; various options are displayed. 

3.	 Set mm in the Main Units option, if not set already. Close the Construction Options dialog 
box. 

 
4.	 Choose Windows > Palette from the menu bar if the Palette is not displayed by default. 

Choose the Construction tab from the Palette; various tools in the tab are displayed. 

5.	 Double-click on the Grid Preset tool in the Construction tab of the Palette; the  
Preset Grid Options dialog box is displayed.    

6.	 Enter 100 and 3200 in the Grid Spacing and Perspective Grid Extent edit boxes, respectively. 
Next, choose the Go button; the grid spacing is set to 100 units.

Creating the Base of the Model
	 You need to create the base of the model using the Cylinder tool. 

1.	 Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are     
prompted to enter the position of the cylinder. 

2.	 Enter 0, 0, 25 in the promptline and press ENTER; the cylinder is created, as shown in 
Figure 2-101.

3.	 Exit the Cylinder tool by choosing the Pick Object tool from the Pick tab in the  
Palette.

Scaling the Base
	 The cylinder created may not be of the required shape and size. So, you need to scale it 

using the Transform tools.
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1.	 Select the cylinder from the window and choose the Non-p Scale tool from the  

Transform tab in the Palette; you are prompted to enter the scale factors along the 
X, Y, and Z axes.

2.	 Enter 300, 300, 50 in the promptline and press ENTER; the base is scaled, as shown in 
Figure 2-102.

Figure 2-101  Cylinder created for the base of 
the model

Figure 2-102  Base of the model after scaling

Creating the Stand of the Globe
	 After creating and scaling the base, you need to create the stand of the globe using the 

Cylinder tool.

1.	 Choose the Cylinder tool from the Primitives flyout of the Surfaces tab in the    
Palette; you are prompted to enter the position of the cylinder. 

2.	 Enter 0, 0, 75 in the promptline and press ENTER; the stand of the model is created, as 
shown in Figure 2-103.

Scaling the Stand
	 The stand of the model can be scaled in a way similar to the scaling of the base using the 

Transform tools.

1.	 Choose the Non-p Scale tool from the Transform tab in the Palette; you are      
prompted to enter the scale factors along the X, Y, and Z axes.

2.	 Enter 75, 75, 50 in the promptline; the stand is scaled, as shown in Figure 2-104.

Creating the Ring of the Globe
	 Next, you need to create the ring of the globe using the Torus tool. Before invoking the 

Torus tool, you need to set the parameters of the torus. After changing the parameters of 
the ring, rotate it to get the desired position.

1.	 Choose Primitives > Torus from the Surfaces tab in the Palette and then double-click  
on the Torus tool; the New Torus Options dialog box is displayed. 

2.	 In the Size area of this dialog box, select the Absolute radio button.
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Figure 2-104  Model after scaling the standFigure 2-103  Stand created for the model

3.	 Enter 210, 1.5, 0.15 in the Sweep, Major radius, and Minor radius edit boxes, respectively, 
and then choose the Go button. 

4.	 Enter 0, 0, 250 in the promptline and press ENTER; a ring is created in the window, as 
shown in Figure 2-105. 

5.	 Choose the Rotate tool from the Transform tab in the Palette; you are prompted to  
enter the rotation angle about the X, Y and Z axes.

6.	 Enter 90, 45, 0 in the promptline and press ENTER; the ring is rotated about the X and Y 
axes, as shown in Figure 2-106. 

Figure 2-106  Model after rotating the ringFigure 2-105  Torus created for the ring of the globe

Creating the Globe
	 Next, you need to create the globe using the Sphere tool. 

1.	 Choose Primitives > Sphere from the Surfaces tab in the Palette; you are prompted to  
enter the position of the sphere.

2.	 Enter 0, 0, 250 in the promptline and press ENTER; a globe is created in the window, as 
shown in Figure 2-107.
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Scaling the Globe
	 Next, you need to scale the globe using the Scale tool from the Transform tab. 
 
1.	 Choose the Scale tool from the Transform tab in the Palette; you are prompted to  

enter the scale factor.

2.	 Enter 225 in the promptline and press ENTER; the globe is scaled uniformly along the X, 
Y, and Z axes, as shown in Figure 2-108.

Figure 2-108  Globe created after scaling the sphereFigure 2-107  Sphere created for the globe

Creating the Axial Rod
	 After creating the globe, you need to create an axial rod around which the globe will be 

rotated. This rod needs to be created by using the Cylinder tool. Later, you need to rotate 
and scale this cylinder to get the required position and size of the rod.

1.	 Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are     
prompted to enter the position of the cylinder.

 
2.	 Enter 0, 0, 250 in the promptline and press ENTER; the axial rod is created, as shown in 

Figure 2-109.

Scaling and Rotating the Axial Rod 
	 Next, you need to scale and rotate the axial rod using the Scale and Rotate tools of the 

Transform tab.

1.	 Choose the Non-p scale tool from the Transform tab in the Palette; you are      
prompted to enter the scale factors along the X, Y, and Z axes.

2.	 Enter 15, 15, 350 in the promptline and press ENTER; the axial rod is scaled, as shown in 
Figure 2-110.

3.	 Next, choose the Rotate tool from the Transform tab in the Palette; you are      
prompted to enter the rotation angle about the X, Y and Z axes.
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Figure 2-110  Model after scaling the axial rodFigure 2-109  Model after creating the cylinder 
for the axial rod

4.	 Enter 0, -30, 0 in the promptline and press ENTER; the ring is rotated about the Y-axis, as 
shown in Figure 2-111.

5.	 Choose the Pick Nothing tool from the Pick tab in the Palette to exit the Rotate tool.

Applying the Diagnostic Shading to the Model
	 The model you have created is in the wireframe mode. For a better view, you need to shade 

the model. 

1.	 Choose ObjectDisplay > Diagnostic Shading from the menu bar; the Diagnostic Shade 
dialog box is displayed.

 
2.	 Choose the Multi Color Diagnostic Shader tool in the Shading area; the model is 

shaded. You can choose the other tools in this area to get the required shades. 

3.	 Next, close the Diagnostic Shade dialog box.

4.	 Select the entire model and then clear the Isoparm U and V check boxes in the Display 
area of the Control Panel; the isoparametric curves in the model are hidden. The model 
after hiding the isoparametric curves is displayed, as shown in Figure 2-112.

Note
You can improve the quality of the display of model by selecting the Accurate option from the 
Tessellator area of the Control Panel.

Saving the File
	 To save the above model, create a new project directory c02_tutorials.  

1.	 Choose File > Save from the menu bar; the Save As dialog box is displayed. You can also 
invoke this dialog box by pressing the ALT+S keys.
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Figure 2-112  Model after hiding the 
isoparametric curves

Figure 2-111  Model after rotating the 
axial rod

2.	 Click on the down arrow next to the Go To field and then select the Current Home option 
from the drop-down list; you will be moved to user_data folder which contains all the tutorials.

3.	 Click on the New Project option; the new_project folder is created in the file browser.

4.	 Choose the created folder and rename it as c02_tutorials.

5.	 Next, select the c02_tutorials folder and click the Set Current option from the Save As dialog 
box; the wire folder of the c02_tutorials is displayed in the file browser.

6.	 In the File name field, type c02_tut01 and choose the Save button; Alias Design saves the 
file as c02_tut01.wire. The location of this file is given next:

	 \Alias\user_data\c02_tutorials\wire\c02_tut01.wire

7.	 Choose File > Exit from the menu bar; the confirm message box is displayed.

8.	 Choose the Don’t Save button from the message box to exit the application.

Tutorial 2
 

In this tutorial, you will create a pencil, as shown in Figure 2-113. After creating the model, you 
will shade it to give a realistic look.       			     	       (Expected time: 45 min)

The following steps are required to complete this tutorial:

a.	 Start Alias Design and then start a new wire file.
b.	 Create the base feature of the pencil by using the Cylinder tool.
c.	 Change the pivot point of the base feature by using the Set Pivot tool.
d.	 Scale the base feature by using the Non-p Scale tool.
e.	 Create the tip of the pencil by using the Cone tool.
f.	 Rotate and scale the tip of the pencil by using the options from the Transform tab.
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g.	 Create the eraser holder of the pencil by using the Cylinder tool. 
h.	 Scale the eraser holder by using the Non-p Scale tool.
i.	 Create the base of the eraser by using the Cylinder tool. 
j.	 Change the pivot point of the eraser holder by using the Set Pivot tool and then scale it by 

using the Non-p Scale tool.
k.	 Create the top part of the eraser by using the Sphere tool.
l.	 Rotate the top part of the eraser by using the Rotate tool.
m.	 Shade the pencil by using the Diagnostic Shading option.
n.	 Save the file and exit.

Figure 2-113  3D model of the pencil

Starting a New Wire File
1.	 Start Autodesk Alias Design 2016 by double-clicking on its icon on the desktop of your 

system.

Creating the Base Feature
	 As you have specified the grid and unit settings in Tutorial 1 of this chapter, you need not 

specify them again. With the settings specified in the previous tutorial, you need to create 
the base feature using the Cylinder tool. 

1.	 Choose Primitives > Cylinder from the Surfaces tab in the Palette; you are     
prompted to enter the position of the cylinder. 

2.	 Enter 0, 0, 200 in the promptline and press ENTER; the base feature is created, as shown 
in Figure 2-114.

Changing the Pivot Point
	 The transform operations such as move, rotate, and scale are performed on objects with 

respect to their pivot points. In other words, these operations are made toward or away 
from the pivot points along all directions. In order to scale the base feature in the upward 
direction, you need to change the location of the pivot point from the center to the bottom 
of the cylinder.

1.	 Choose the Set Pivot tool from the Transform tab in the Palette; you are prompted 
to enter the new pivot position.
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2.	 Enter 0, 0, 150 in the promptline and press ENTER; the pivot point is shifted to the bottom 

of the base feature.   
	
Scaling the Base Feature
	 Next, you need to scale the base feature by using the Non-p Scale tool.

1.	 Choose the Non-p Scale tool from the Transform tab in the Palette; you are     
prompted to enter the scale factors along the X, Y, and Z axes.

2.	 Enter 100, 100, 800 in the promptline and press ENTER; the base feature is scaled 
non-uniformly along the X, Y, and Z axes, as shown in Figure 2-115.

Figure 2-115  Base feature scaledFigure 2-114  Base feature

Creating the Tip of the Pencil
	 After creating the base feature, you need to

Figure 2-116  Model after creating the tip of 
the pencil

    
create the tip of the pencil by using the Cone 
tool.

1.	 Choose Primitives > Cone from the Surfaces 
tab in the Palette; you are prompted to enter 
the position of the cone in the promptline. 

2.	 Enter 0, 0, 150 in the promptline and press 
ENTER; the tip of the pencil is created, as shown 
in Figure 2-116.

Scaling and Rotating the Tip of the 
Pencil
	 Next, you need to scale and rotate the tip of the pencil by using the Scale and Rotate tools 

in the Transform tab.

1.	 Choose the Non-p Scale tool from the Transform tab in the Palette; you are prompted to 
enter the scale factors along the X, Y, and Z axes.



Working with Basic Tools					                                      2-67

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

2.	 Enter 100, 100, 150 in the promptline and press ENTER; the tip of the pencil is scaled, as 
shown in Figure 2-117. 

3.	 Choose the Rotate tool from the Transform tab in the Palette; you are prompted  
to enter the rotation angle about the X, Y and Z axes.

4.	 Enter 180, 0, 0 in the promptline and press ENTER; the tip is rotated about the X-axis, as 
shown in Figure 2-118.

Figure 2-118  Model after rotating the tipFigure 2-117  Model after scaling the tip

Creating the Eraser Holder
	 Next, you need to create the eraser holder by using the Cylinder tool.

1.	 Choose Primitives > Cylinder from the Surfaces tab in the Palette. Next,              
double-click on the Cylinder tool; the Cylinder Options dialog box is displayed.

2.	 Choose the 0 tool from the Caps area.

3.	 Next, choose the Go button to exit the Cylinder Options dialog box; you are prompted to 
enter the position of the cylinder.

4.	 Enter 0, 0, 950 in the promptline and press ENTER; the eraser holder is created in the 
window, as shown in Figure 2-119.

 
Scaling the Eraser Holder
	 Next, you need to scale the eraser holder non-proportionally by using the Transform tab.

1.	 Choose the Non-p Scale tool from the Transform tab in the Palette; you are     
prompted to enter the scale factors along the X, Y, and Z axes.

2.	 Enter 110, 110, 50 in the promptline and press ENTER; the eraser holder is scaled, as 
shown in Figure 2-120.
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Figure 2-120  Model after scaling the eraser holderFigure 2-119  Model after creating the eraser holder 

Creating the Base of the Eraser
	 After creating the eraser holder, you need to create the base of the eraser using the Cylinder 

tool.

1.	 Choose the Cylinder tool from the Primitives flyout of the Surfaces tab in the    
Palette; you are prompted to enter the position of the cylinder.

 
2.	 Enter 0, 0, 1000 in the promptline and press ENTER; the base of the eraser is created, as 

shown in Figure 2-121.

Changing the Pivot Point and Scaling the Bottom Part of the Eraser
	 You need to change the position of the pivot point from the center to the bottom of the 

eraser and then scale it with respect to the new position of the pivot point.

1. 	 Choose the Set Pivot tool from the Local flyout of the Transform tab in the Palette;  
you are prompted to enter the new pivot position.

2.	 Enter 0, 0, 950 in the promptline and press ENTER; the pivot point is shifted to the  bottom 
of the eraser, which is the top of the base feature.

3.	 Choose the Non-p Scale tool from the Transform tab in the Palette; you are     
prompted to enter the scale factors along the X, Y, and Z axes.

4.	 Enter 100, 100, 50 in the promptline and press ENTER; the base of the eraser is scaled, as 
shown in Figure 2-122.

Creating the Top Part of the Eraser 
	 After creating and scaling the bottom part of the eraser, you need to create the hemispherical 

top part of the eraser by using the Sphere tool.

1.	 Choose Primitives > Sphere from the Surfaces tab in the Palette and then   
double-click on it; the Sphere Options dialog box is displayed. 
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Figure 2-122  Model after scaling the base of 
the eraser

Figure 2-121  Model after creating the base 
of the eraser

2.	 Enter the value 180 in the Sweep edit box and press ENTER.

3.	 Choose the Go button to exit the Sphere Options dialog box.

4.	 Enter 0, 0, 1000 in the promptline and press ENTER; the hemispherical top part is created 
in the window, as shown in Figure 2-123.

Rotating the Top Part of the Eraser
	 Next, you need to rotate the hemispherical top part of the eraser about the X-axis using the 

Transform tab.
 
1.	 Choose the Rotate tool from the Transform tab in the Palette; you are prompted to  

enter the rotation angle about the X, Y, and Z axes.

2.	 Enter 90, 0, 0 in the promptline and press ENTER; the hemispherical top part is rotated 
about the X-axis, as shown in Figure 2-124.

Figure 2-124  Model after rotating the top 
part of the eraser about X-axis 

Figure 2-123  Model after creating the 
hemispherical top part of the eraser
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Applying the Diagnostic Shading to the Model
	 The model that you have created is in the wireframe mode. For a better view, you need to 

shade the model. 

1.	 Choose ObjectDisplay > Diagnostic Shading from the menu bar; the Diagnostic Shade 
dialog box is displayed. 

2.	 Choose the Multi Color Diagnostic Shader tool from the Shading area; the model is shaded. 
You can also choose the other tools from this area to get different shades.

3.	 Select the entire model and then clear the Isoparm

Figure 2-125  Model after hiding the 
isoparametric curves

 
U and V check boxes in the Display area of the 
Control Panel; the isoparametric curves in the model 
are hidden. The model after hiding the isoparametric 
curves is displayed, as shown in Figure 2-125.

Saving the File
	 You need to save the model created in the c02_tutorials 

folder with the name c02_tut02. As you have created 
the c02_tutorials folder in Tutorial 1 and set it as the 
current project, you need not create a new folder. 

1.	 Choose File > Save As from the menu bar; the Save 
As dialog box is displayed. You can also invoke this 
dialog box by pressing the ALT+S keys.

2.	 Enter c02_tut02 in the File name edit box and then choose the Save button; Alias Design 
saves the file as c02_tut02.wire. 

	 The location of this file is given below:

	 \Alias\user_data\c02_tutorials\wire\c02_tut02.wire

3.	 Choose File > Exit from the menu bar; the confirm message box is displayed.

4.	 Choose the Don’t Save button from the message box to exit the application.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter: 

1.	 A line joining the CVs of a curve is known as __________.

2.	 There are __________ options in the Ellipse definition area that are used to create an ellipse.

3.	 The __________ area is used to specify parameters for edit points while working on the New 
CV Curve tool.
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4.	 While working with curves, you can view the changing degrees in the __________.

5.	 You can enter coordinates in the __________ to specify the position of the primitives such 
as sphere, cylinder, cone, and so on.

6.	 You can invoke a tool from the shortcut menu that is displayed when you right-click on a 
particular tab in the Palette. (T/F)

7.	 You can hide or show CVs/Hulls displayed on curve-on-surface. (T/F)

8.	 You can change the parameters of a primitive by double-clicking on its tool. (T/F)

9.	 In the Cylinder Options dialog box, 1 is selected as the default degree. (T/F)

10.	 In Alias, a circle is considered as a primitive. (T/F) 

Review Questions
Answer the following questions:

1.	 Which of the following pick tools is used to pick a single entity from a group of entities?

		  (a) Pick Object				    (b) Pick Component
		  (c) Pick Template			   (d) Pick CV

2.	 How many primitives are available in the Surfaces tab of the Palette?
	
		  (a) 2					     (b) 4
		  (c) 6					     (d) 7

3.	 Which of the following options is not available in the Caps area of the Cylinder Options 
dialog box?

		  (a) 0					     (b) 1
		  (c) 2					     (d) 3

4.	 Which of the following is not a CV symbol?

		  (a) Box					     (b) u
		  (c) x					     (d) *

5.	 While working on curves using the __________ option, you can increase the degree of the 
curve progressively up to the final degree.

6.	 The __________ tab is used to invoke the Move tool from the Palette or the Shelves window.

7.	 Span is the length of a curve segment between two edit points. (T/F)
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8.	 Axis length ratio is the ratio of the minor axis to the length of the major axis of an ellipse. 

(T/F)

9.	 If you create a curve with uniform knot spacing, the first and last edit point parameter values 
of the curve will be equal to 0 and chord length, respectively. (T/F)

10.	 CVs are preferred over edit points for editing a curve. (T/F)

Exercises

Exercise 1 
Create a table and a tennis ball, as shown in Figure 2-126. After creating the model, you need 
to shade it to give it a realistic look.                			        (Expected time: 45 min)

Hint
Use the Cube tool for creating the legs of the table. After creating the legs, scale them 
non-uniformly and rotate them 45-degree about two axes. 

Figure 2-126  Model for Exercise 1
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Exercise 2 
Create a pen stand, as shown in Figure 2-127. After creating the model, you need to shade it 
to give it a realistic look. 			      		        (Expected time: 30 min)

Figure 2-127  Model for Exercise 2
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Answers to Self-Evaluation Test
1. hull, 2. two, 3. Knot Spacing, 4. Control Panel, 5. promptline, 6. T, 7. F, 8. T, 9. F, 10. T


